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Preface

■ Contacting Unica technical support
N40001

Contacting Unica technical support
If you encounter a problem that you cannot resolve by consulting the documentation,
your company’s designated support contact can log a call with Unica technical support.
Use the information in this section to ensure that your problem is resolved efficiently and
successfully.

If you are not a designated support contact at your company, contact your Unica
administrator for information.

Information you should gather
Before you contact Unica technical support, you should gather the following information:

• A brief description of the nature of your issue.

• Detailed error messages you see when the issue occurs.

• Detailed steps to reproduce the issue.

Contact information for Unica technical support
For ways to contact Unica technical support, see the Unica Product Technical Support
web site: (http://www.unica.com/about/product-technical-support.htm).
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1 Introduction to Unica
NetInsightOnDemand

■ About Unica NetInsight
■ About roles in Unica NetInsight OnDemand
■ About this guide
■ To log on to NetInsight

N50001

About Unica NetInsight
Unica NetInsight provides the critical information and insight you need to improve web
site design, internet marketing effectiveness, and your customer's experience.

Using Unica NetInsight, you can identify which content is popular and which is ignored.
You can see where users are dropping off your site.

Unica NetInsight lets you analyze online campaigns (including media buys, email, and
search engine marketing) and offline campaigns (including direct mail, catalog, and call
center activities). You can even analyze the response to campaigns across channels.

N60002

About roles in Unica NetInsight OnDemand
Every user of Unica NetInsight OnDemand is assigned a role by the Unica NetInsight
administrator in his or her organization.

Your role determines the actions you can perform and the interface elements you see.
There are four standard roles available in Unica NetInsight OnDemand:

• Business User

• Enhanced Business User

• Power User
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• OnDemand Administrator

Your administrator can tell you what your role is.
N70002

About this guide
This guide contains information about the additional capabilities granted by the Power
User role over and above the capabilities in the Enhanced User Role. Consult the
NetInsight OnDemand Reports Users Guide for information about capabilities both roles
have in common.

N80001

To log on to NetInsight
1. In your Web browser, enter the URL your Unica NetInsight administrator gave you.

The Unica NetInsight User Logon page appears.

2. In the User name box, enter the user name your Unica NetInsight administrator
gave you. (The user name is case-insensitive.)

3. In the Password box, enter your Unica NetInsight password.

4. Click Log on.
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2 Working with reports

■ Working with reports
■ To rename a report
■ To remove a report
■ Emailing reports
■ Archiving Reports

N90002

Working with reports
This section provides information on the report tasks that require the Power User role or
higher.

NA0001

To rename a report
1. In the Profile containing the report, click the Custom tab, select the report you want

to rename, and click Edit Report.

You can also display the report you want to rename and click the Report Designer

icon ( ).

The Report Summary screen opens.

2. Click Report title.

The Report description screen opens.

3. In the Report title field, enter the new name you want for the report.

4. Click Continue.
NB0001
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To remove a report
Removing the report deletes it from the Custom Report Wizard and from the list of
available reports on the Reports tab. However, removing a report does not delete any
archived copies of the report.

1. View the profile that contains the report you want to delete.

2. Click the Custom tab.

3. Select the report you want to remove.

4. Click Remove Report.

The specified report is permanently removed.
NC0002

Emailing reports
■ Emailing multiple reports and emailing reports automatically
■ To create an email task
■ To create an email alert

NC000B

Emailing multiple reports and emailing reports
automatically
If you routinely send the same reports to the same people, you can create one or more
email tasks which specify which reports should go to which recipients and in which
format.

You can also create an email alert that executes an email task if the value of a specified
metric meets the criteria you specify for the alert.

Reports sent as part of an email task or email alert always are sent in Full mode.
NE0001

To create an email task
■ To create an email task
■ To add or edit reports for an email task
■ To add or edit recipients for an email task
■ To test an email task
■ To execute an email task
■ To edit an email task
■ To delete an email task

NE0009

To create an email task
1. While working with a profile containing the reports you want to email, click Options.
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2. In the left panel, under Email, click Email Tasks.

The Available email tasks screen opens.

3. Click Add.

The Email task description screen opens.

4. In the Name of task field, enter the name you want displayed for this email task in
the Available email tasks list.

Use a name that clearly identifies the task.

5. In the From address field, enter the email address from which the reports in this
email task will be mailed to users.

Any email messages returned as undeliverable, as well as any replies sent by
recipients, are sent to this address.

If you do not enter an address, Unica NetInsight uses the email address
specified for the From address option in the administrative options.

6. In the Subject of email field, enter the text you want to appear in the subject line of
the email the recipients receive.

7. In the Format of reports list, select the report format you want to use.

8. In the Time period list, select the time period for which the metric will be calculated.

9. If you have scheduled the -email command-line option to automatically execute all
the email tasks for this profile but you do not want this email task executed with the
group, select the Exclude from batch execution check box.

This email task is then executed only when you use the -emailtask command-line
option or select the task in the Available email tasks list and click Execute.

This option is especially useful when most of your email tasks are executed daily
and you want to create a task that executes weekly, monthly, or quarterly.

10. In the Additional text field, enter the text you want to include in the body of the
email message that contains the reports and graphs.

For example, you could include descriptions of the data contained in each report.

11. Click Save Options and then click Continue.

Before the email task is functional, you must:

• Add one or more reports to the email task

• Add one or more recipients to the email task
N100001

To add or edit reports for an email task
You must create the email task to add reports to before completing the instructions
below.
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When you execute an email task, Unica NetInsight includes all the reports in the email
task in one email message. You can specify the order in which you want the reports to
appear when you add reports to the email task.

1. While working with the profile, click Options.

2. In the Options panel, under Email, click Email Tasks.

The Available email tasks screen opens.

3. Select the email task to add reports to.

4. Click Reports.

The Reports to be sent for profile screen opens.

5. Select reports in the Available reports list and use the right arrow button to move
reports you want to send to the Selected reports list. You can use the left arrow
button to remove any reports you do not want to send.

6. Select reports in the Selected reports list and use the up and down buttons to
adjust the order of reports to be included.

7. When all the reports you want to include are in the Selected reports list and in the
desired order, click Save Options and then click Continue.

N110001

To add or edit recipients for an email task
You must create the email task to add recipients to before completing the instructions
below.

If the list of recipients is particularly long, you may want to contact your email
administrator about creating an alias for multiple email addresses on your mail server.
Using this method allows you to avoid entering a long list of email recipients. You can
then mail the reports to the alias and all the recipients will receive them.

1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Tasks.

The Available email tasks screen opens.

3. Select the appropriate email task.

4. Click Recipients.

The Recipients of reports for profile screen opens.

5. Click Add.

The Email address field appears.

6. Enter the email address of one person who should receive the reports and click
Add.

7. Click Continue.
N120001
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To test an email task
You can test an email task to ensure that the resulting email is what you want without
sending it to everyone on the recipient list. You can specify a test email account to
receive the reports for verification purposes. You can also use this feature to send the
reports in an email task to a list of recipients that is different than the list specified in the
email task.

Unica NetInsight does not display errors it encounters while executing the email task
when you are testing. If you need to troubleshoot an email task, execute it from the
nettracker.exe command line using the -emailtask option. You can use the
-recipients option to send the reports to a different list of recipients.

1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Tasks.

The Available email tasks screen opens.

3. Select the email task to test.

4. Click Test.

The Test email task screen opens.

5. In the Email address field, enter the list of email addresses to which you want the
reports in the email task sent.

Separate multiple addresses with commas or semicolons. (Spaces before or after
the commas are ignored.)

6. Click Execute.
N130001

To execute an email task
You must do the following before executing an email task:

• Create the email task

• Add reports to an email task

• Add recipients to an email task

When you execute an email task, Unica NetInsight includes all the reports in the email
task in one email message and sends it to the specified recipients.

1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Tasks.

The Available email tasks screen opens.

3. Select the email task to execute.

4. Click Execute.
N140001
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To edit an email task
1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Tasks.

The Available email tasks screen opens.

3. Select the appropriate email task.

4. Click Edit.

The Email task description screen opens.

5. Edit values as desired and click Save.

You can now:

• Add reports to an email task

• Add recipients to an email task
N150001

To delete an email task
When you delete an email task, all email alerts that use the email task are
automatically deleted as well.

1. While working with the profile, click Options.

2. In the Options panel, select Email > Email Tasks.

The Available email tasks screen opens.

3. Select the email task to delete.

4. Click Delete.

The email task is deleted.

5. Click Continue.
NF0001

To create an email alert
■ To create an email alert
■ To modify filters for an email alert
■ To test an email alert
■ To execute an email alert
■ To edit an email alert
■ To delete an email alert

NF0009

To create an email alert
You must create at least one fully-configured email task before you can create an email
alert.
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1. While working with the profile containing the email task that should be executed,
click Options.

2. In the left panel, under Email, click Email Alerts.

The Available email alerts screen opens.

3. Click Add.

The Email alert description screen opens.

4. In the Name of alert field, enter the name you want displayed for this alert in the
Available email alerts list.

Use a name that will clearly identify the alert.

5. In the Email task list, select the email task to be executed if the criteria you specify
for the alert are met.

6. In the Time period list, select the time period for which the metric will be calculated.

• To include data from a specified number of the specified time period units,
starting with the current unit and counting back, select Current, enter the
desired number of units in the first field, and select a time period unit from the
drop-down list. For example, specifying Current 2 days includes data from
today and yesterday.

• To include data from a specified number of the specified time period units,
starting with the previous unit and counting back, select Previous, enter the
desired number of units in the first box, and select a time period unit from the
drop-down list. For example, specifying Previous 2 days includes data from
yesterday and the day before yesterday.

7. In the Metric list, select the metric for which you want to calculate a value.

8. In the Execute if calculated value is list, select the comparison type to use to
compare the calculated value to the threshold value.

9. Enter a number for the threshold value in the next field to the right.

10. Click Save Options, then click Continue.

You can now add filters to the alert.
N160001

To modify filters for an email alert
1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Alerts.

The Available email alerts screen opens.

3. Select the email alert to modify filters for.

4. Click Filters.

The Filters that belong to email alert screen opens.

5. To add a filter:
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a. Click Add Filter.

The Available filters screen opens.

b. Select a filter and click Continue.

The Filter description screen opens.

c. Select one or more bins for the filter and click Continue. For a string variable, fill
in the Filter Description screen.

6. To edit a filter:

a. Select the filter to edit.

b. Click Edit Filter.

The Available filters screen opens.

c. Edit the filter as desired and click Continue.

7. To delete a filter:

a. Select the filter to delete.

b. Click Delete Filter.

The filter is deleted.

8. Repeat steps 5 through 7 until the filter list is complete.

9. Click Save Filters.
N170001

To test an email alert
Before you execute an email alert, you should test it to troubleshoot the criteria you
specified for the alert. When you test an email alert, a message displays the calculated
value of the metric values that match the filters you specified, whether this calculated
value meets the threshold value, and whether or not the alert would have been
executed.

1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Alerts.

The Available email alerts screen opens.

3. Select the email alert to test.

4. Click Test.

The Test email alert screen opens, showing the results of the test.
N180001

To execute an email alert
You must do the following before executing an email alert:

• Create an email task containing one or more reports

• Create the email alert
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• Optionally add filters to the email alert

1. While working with the profile, click Options.

2. In the left panel, under Email, click Email Alerts.

The Available email alerts screen opens.

3. Select the email alert to execute.

4. Click Execute.
N190001

To edit an email alert
1. While working with the profiles, click Options.

2. In the left panel, under Email, click Email Alerts.

The Available email alerts screen opens.

3. Select the email alert to edit.

4. Click Edit.

The Email alert description screen opens.

5. Edit the fields on this screen as desired and click Save.

You now add filters to the alert.
N1A0001

To delete an email alert
1. While working with the profile, click Options.

2. In the Options panel, select Email > Email Alerts.

The Available email alerts screen opens.

3. Select the email alert to delete.

4. Click Delete.

The email alert is deleted.

5. Click Continue.
ND0001

Archiving Reports
■ About archiving reports
■ To archive a report
■ To remove archived reports

ND0009
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About archiving reports
Because you can generate a report at any time, there is generally no need to archive a
separate copy of a report for record keeping. However, archived reports provide a static
snapshot of data and use fewer database resources, so you may wish to archive reports
to make better use of your resources or to preserve a view of data at a particular point
in time.

You can view, export, and print archived reports.

Unica NetInsight always archives reports using Full mode, regardless of the reporting
mode you are currently using in the profile.

You cannot drill down into archived reports. An archived report has no links.

N1B0001

To archive a report
1. View the Profile that contains the report you want to archive.

2. Display the Report Summary page for the report you want to archive.

You can open the Report Summary page by clicking the Report Designer icon

( ), or by selecting the report in the Custom tab and clicking Edit Report.

3. Click Archive.

4. In the Report title field, modify the name of the report as needed.

5. If you want the filters to be listed on the report, select the Display filters on report
check box.

6. Click Continue.

The report is archived.
N1C0001

To remove archived reports
1. View the profile that contains the archived report you want to remove.

2. Click the Options tab.

3. In the Unica NetInsight Options drop-down list at the top of the screen, select
Remove Archived Reports.

The Archived reports screen opens, listing the archived reports

4. Do one of the following to remove the reports.

• To remove only some of the archived reports, select them in the list and click
Remove Selected Reports.

• To remove all the reports, click Remove All Reports.

The selected reports are permanently removed from the archive.
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3 CreatingReports

■ To save a customized report
■ To save a customized report
■ Creating a custom dashboard
■ To display axis labels for dashboard reports

N1D0001

To save a customized report
If you want the saved report to keep the time period specified in the calendar, you must
specify the time period using date filters created using the Custom Report Wizard or the
Discovery Panel. The calendar setting is not preserved in saved reports.

When you customize a report, either by using the Custom Report Wizard or by
modifying an existing report using the Report Designer, you can save your new or
modified report from the Report Summary screen as follows:

1. Click Save.

2. Provide a name for your report in the Report title field.

If you are editing an existing report from the Custom tab, you can overwrite the
report with your changes. If you are editing a pre-existing report from the Report
Designer, you must specify a new name to save your modified report.

3. If you have custom help written for this report, you can specify the URL of the web
page to display in the Help topic URL field.

4. Enable Save as new report, unless you want to override a pre-generated report
you edited using the Custom link.

You should save all reports as new reports. If you overwrite pre-generated
reports, your changes will be lost when the profile is updated.

5. Enable Display filters on report to display any applied filters at the top of the
report.
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6. Enable Automatically update full report to automatically update the report for Full
reporting mode when the profile is updated.

7. Enable Automatically update sample report to automatically update the report for
Sample reporting mode when the profile is updated.

8. Enable Automatically archive report to preserve a copy of the report each time the
profile is updated, instead of having newer versions saved on top of older ones.

This option is only available if the report has a relative date filter (Yesterday,
Today, Previous week, etc.).

You cannot drill down into archived reports. Archived reports have no links.

9. Choose a folder from the Save report to folder drop-down list.

10. Click Continue.

Your custom report has been saved. You may need to refresh your report list for the
report to be visible in the list.

N1D0001

To save a customized report
If you want the saved report to keep the time period specified in the calendar, you must
specify the time period using date filters created using the Custom Report Wizard or the
Discovery Panel. The calendar setting is not preserved in saved reports.

When you customize a report, either by using the Custom Report Wizard or by
modifying an existing report using the Report Designer, you can save your new or
modified report from the Report Summary screen as follows:

1. Click Save.

2. Provide a name for your report in the Report title field.

If you are editing an existing report from the Custom tab, you can overwrite the
report with your changes. If you are editing a pre-existing report from the Report
Designer, you must specify a new name to save your modified report.

3. If you have custom help written for this report, you can specify the URL of the web
page to display in the Help topic URL field.

4. Enable Save as new report, unless you want to override a pre-generated report
you edited using the Custom link.

You should save all reports as new reports. If you overwrite pre-generated
reports, your changes will be lost when the profile is updated.

5. Enable Display filters on report to display any applied filters at the top of the
report.

6. Enable Automatically update full report to automatically update the report for Full
reporting mode when the profile is updated.
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7. Enable Automatically update sample report to automatically update the report for
Sample reporting mode when the profile is updated.

8. Enable Automatically archive report to preserve a copy of the report each time the
profile is updated, instead of having newer versions saved on top of older ones.

This option is only available if the report has a relative date filter (Yesterday,
Today, Previous week, etc.).

You cannot drill down into archived reports. Archived reports have no links.

9. Choose a folder from the Save report to folder drop-down list.

10. Click Continue.

Your custom report has been saved. You may need to refresh your report list for the
report to be visible in the list.

N1E0001

Creating a custom dashboard
■ About dashboards
■ To create a dashboard
■ To create a graph dashboard section
■ To create a text dashboard section
■ To copy a dashboard section

N1E0007

About dashboards
Dashboards allow you to collect together relevant, key charts and textual data that can
help you better monitor and understand your business on an ongoing basis. You can
create an unlimited number of focused, subject-area reports displaying your key
performance indicators (KPIs). You can create separate dashboards for different
individuals or roles within your organization. You can filter dashboards to report only on
the data that is relevant for the viewer.

You can create and manage dashboards, which are collections of charts and data from
reports within your profile. profiles containing the dashboards can then be scheduled to
update on a regular, periodic basis to consistently deliver up-to-date information. You
can set up email tasks to automatically email dashboard reports to interested parties.
You can also configure email alerts to send email to the appropriate people when a KPI
exceeds some threshold.

About dashboard sections
Dashboards are composed of sections. A section can be one of two types: graph or
text.

Graph sections contain a chart displaying a metric from one of the reports in the profile.
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Text sections contain one or more data fields. A data field displays a dimension value or
an aggregate metric. A single text section can contain data from multiple reports in the
profile.

Data fields in text sections can be one of the following types:

• Average—Displays the average value for the specified metric for the specified time
period.

• Total—Displays the sum of all values for the specified metric.

• Top—Displays the dimension value from the specified dimension with the highest
value for the specified metric.

• Bottom—Displays the dimension value from the specified dimension with the lowest
value for the specified metric.

N200001

To create a dashboard
You can create a dashboard within the profile you are viewing.

1. Click the Custom tab.

The Managing Reports screen opens.

2. Click Create Report.

3. Select Define a new report, then Dashboard.

4. Click Continue.

5. If you want to create a report for a fixed time frame, click the Calendar icon and use
the calendar to specify the time frame.

You can specify a relative time frame using date filters later in the process.

6. Specify each section in the dashboard by doing one of the following:

You can edit a section by selecting it and clicking Edit. You can delete a section by
selecting it and clicking Delete.

a. Create a graph dashboard section

b. Create a text dashboard section

c. Use a dashboard section from an existing dashboard

7. Arrange the sections the way you want them to appear in the dashboard, then click
Continue.

Select a section and use the up and down arrow keys to move it up and down in the
current column, and use the left and right arrows to move the section from one
column to another.

8. Enter a report title, then click Continue.

9. Specify any filters you want applied to the report, then click Continue.
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If you want to create a report for a relative time frame, create a date filter that
specifies the time frame.

The A/B Groups screen opens.

10. If you want to apply two sets of filters and compare the resulting reports, enter the
two groups of filters, then click Continue.

By default, the two groups are named Group A and Group B. You can change the
names.

The Report Summary page opens.

You can now Run, Save, Email, Archive, or Export this dashboard report.
N210001

To create a graph dashboard section
1. At the Designing the Dashboard screen, click Add.

The Adding a Section screen opens.

2. In the Section title field, enter the text you want to label this section in the
dashboard.

If you leave this field blank, Unica NetInsight will use the name of the report entered
in the Data source field as the section title.

3. In the Section type list, select Graph.

4. In the Data source list, select the report to serve as the source of the data for the
dashboard section.

The default values of the other options on this screen may change, depending on
the data source you select.

5. In the Type of graph list, select the type of graph that will be used to display the
data in this section

6. In the Graph data set list, select the data set in the selected data source to provide
the data for the dashboard section.

7. In the Values in graph list, select the number of values (1, 2, 3, 4, 5, 10, 15, 20, 25,
50, 75, or 100) that will appear in the graph for this dashboard section. An All data
option is available for some data sources. You can also choose to use the default
setting for the profile.

8. Clear the Hide axis title check box if you want the dashboard to display X,Y axis
labels for this section. On pie charts, the Graph data set label will be displayed.

9. Click Continue.
N220001

To create a text dashboard section
1. At the Designing the Dashboard screen, click Add.

The Adding a Section screen opens.
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2. In the Section title field, enter the text you want to label this section in the
dashboard.

If you leave this field blank, Unica NetInsight will use the name of the report entered
in the Section links field as the section title.

3. In the Section type list, select Text.

The remaining options on the page change.

4. In the Section links field, select the report to display when users click the section
heading on the dashboard.

Now you need to add the fields you want in the section.

5. Click Add.

The Adding a Field screen appears.

6. In the Field title box, enter a title for the field.

If you leave this field blank, Unica NetInsight uses the name of the report entered in
the Report link field as the name of the field title.

7. In the Field type box, select a field type.

The remaining options on the page may change depending on the field type you
select.

8. Specify how to determine the value for the field using the options below that are
appropriate for the field type:

a. Time period (Average fields)—the time period to use to determine the average.

b. Metric (Total, Average and Top fields)—the metric to supply the value for the
field.

c. Dimension (Top and Bottom fields)—the dimension to supply the value.

d. Order by (Top and Bottom fields)—the metric to use to determine the top or
bottom value for the specified dimension.

9. In the Report link box, select the report to display when users click the field’s value
in the dashboard.

10. Click Continue to add the field to the section.

11. Continue creating fields until you have created all the fields you want for this
section.

Fields appear in the dashboard section in the order they appear in the Fields list.
You can use the Move Up and Move Down arrows to arrange the fields in the
desired order.

You can edit or delete a field by selecting it in the Fields list and clicking Edit or
Delete.

12. When the Fields list is complete, click Continue.
N230001
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To copy a dashboard section
When you specify a dashboard section for a dashboard, you can start by copying an
existing dashboard section and editing it if necessary instead of creating a section. You
can copy any saved dashboard section in the profile. You cannot copy sections from
new, unsaved dashboards or sections added to existing dashboards since they were
last saved.

Once you have added the copy of the section to the dashboard, you can edit the copy
by selecting it at the Designing the Dashboard screen and clicking Edit.

1. At the Designing the Dashboard screen, click Copy.

The Copy a Dashboard Section screen opens.

2. In the Source dashboard field, select the dashboard that contains the section you
want to copy.

3. In the Section to copy list, select the dashboard section to copy.

4. Click Continue.
N1F0001

To display axis labels for dashboard reports
By default, Unica NetInsight does not display X,Y axis labels for reports displayed in a
dashboard. You can enable axis labels for a dashboard report as described below.

X,Y axis labels pertain to bar and line charts only. For pie charts, rather than an axis
label, the Graph data set label is displayed.

1. With the desired dashboard displayed, click the Report Designer icon ( ).

The Report Summary page opens.

2. In the Report description dialog, click the Left column or Right column link.

3. In the Dashboard sections dialog, select the desired report and click Edit.

4. In the Section description dialog, uncheck Hide axis titles.

5. Save the report.

Axis labels for the report are displayed the next time the profile is updated.
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4 Configuring Reporting
Options

■ About reporting options
■ Specifying auto-updated reports
■ Creating custom metrics
■ Creating filter groups
■ Specifying a sample size

N240001

About reporting options
The reporting options apply to all the reports in the profile. They enable you to create
custom metrics for use on any report in the profile, create filter groups, specify the time
period for which reports will be automatically generated during profile updates, and
control which dimensions are reportable.

N250001

Specifying auto-updated reports
■ About auto-updating
■ To specify which reports auto-update

N250007

About auto-updating
Auto-updating reports are generated every time the profile is updated. In general, you
want a report to update automatically if all of the following are true:

• You are frequently importing data for the report's time frame into the profile.

• You need to see the report on a regular basis.
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• You would like the report to be available instantly.

Reports with relative time frames (for example, yesterday or current month) should
generally be set to update automatically.

You can save time by not auto-updating the report if either of the following are true:

• The report is for a fixed time frame in the past for which all the data has been
imported.

• You need to see the report infrequently and can run it ad-hoc.

All of the reports that appear in the Available Reports list on the Reports tab by default
are set to update automatically. Reports you create only update automatically if you
select one of the auto-update check boxes when you save the report.

You can manage which reports are auto-updated at the Auto-Updated Reports option
screen. (This screen is only available at the profile options. You cannot access it from
the default profile options.)

Privileges related to auto-updating
You can only access the Auto-Updated Reports screen if you have the Options:
Reporting: Auto-Updated Reports privilege.

Reporting mode and auto-updating
If sampling is enabled for a profile, the Auto-Updated Reports option screen allows you
to change the report lists for both Full mode and Sample mode, regardless of your
reporting mode privileges. In general, updates are faster if there are fewer auto-updated
reports in Full mode. You should consider auto-updating in Full mode only those
reports you need to meet your reporting requirements and using Sample mode to
auto-update reports identifying overall trends.

N290001

To specify which reports auto-update
1. View the profile whose reports you want to manage.

2. Click the Options tab.

3. From the Options panel select Reporting > Auto-Updated Reports.

The Auto-Updated Reports option screen opens.

4. As desired, select and move reports between the two lists to specify which reports
auto-update.

5. If sampling is enabled for the profile, the initial set of lists controls auto-updating for
Full reporting mode. To specify auto-updating for reports running in Sampled mode,
click Edit Sample Reports.

N260001
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Creating custom metrics
■ About custom metrics
■ To create a custom filtered metric
■ To create a multiple input custom metric
■ To edit a custom filtered metric
■ To edit a multiple input custom metric
■ To delete a custom metric

N260007

About custom metrics
You can create metrics that will be available for use on any report in the profile. You
can create two types of custom metrics:

• Metrics based on existing metrics, but with added filters

• Metrics that are derived from mathematically combining two existing metrics. Once
you create a custom metric, it can be used to build other custom metrics, so it is
possible to build more complex computations using multiple variables by nesting
custom metrics.

N2A0001

To create a custom filtered metric
If you are adding filter groups to the custom filtered metric, you must define the filter
group before performing this task.

1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Custom Metrics.

The Custom metric definitions screen opens.

3. Click Add.

The Custom metric type screen opens.

4. In the Select custom metric type list, select Filtered Metric.

5. Click Continue.

The Custom metric definition screen opens.

6. In the Name field, enter a name for the metric. The name is used internally.

The name must be a single word, with only alphanumeric characters, and the first
character must be a letter.

7. In the Title field, enter a title for the metric.

The title appears in lists of metrics. It is also the basis for the title of the column
containing the metric data.

8. In the Description field, enter a description for the metric.
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The description is the explanation of the metric's column that appears in the page
help for the report.

9. From the Base metric list, select the metric that provides the data to be filtered for
the current metric.

10. Check the Graphable field to have the data from this metric to be available for
graphing in the report graph.

11. Check the Display percentage of total field to have a percentage to display in the
column as well as a number.

12. From the Alignment list, select how the values are aligned in the report column.

The options are Center, Left, and Right.

13. In the Minimum twips field, enter the minimum number of twips for the metric's
column in reports.

A twip equals 1/1440 of an inch. This option affects only those reports that are
exported in RTF format (usually for use in Microsoft Word).

14. In the Recommended twips field, enter the recommended number of twips for the
metric's column in reports.

Unica NetInsight tries to make the column the recommended width.

15. Click Continue.

The Filters for . . screen opens.

16. Add one or more filters or filter groups to the custom metric.

a. Click Add.

The Available filters screen opens.

b. Select a dimension, or to add a defined filter group, select Filter Group.

c. Click Continue.

If you select a dimension, the Filter description screen opens.

If you select Filter Group, a list of defined filter groups open.

d. Complete the screen as required:

• If you selected a string dimension, select that or that do not from the first
list.

Then select a matching type from the second list.

Then enter a string in the field, or select a value from the Or select from
this menu list.

• If you selected a numeric dimension, select a value from the list.

• If you selected Filter Group, select the filter group to use.
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Click Add as Group to add the complete filter group, so you are not able to
remove individual filters from the custom metric. Or click Add as Filters to
add all filters from the group individually, so you can delete filters from the
custom metric.

e. Click Continue.

f. Repeat steps a through e until you have added all required filters.

g. Click Continue.

The custom metric is now available on the Metrics page of the Custom Report
Wizard.

To make the custom metric available on the Discovery Panel, you must add it to a
group in one or more metrics lists.

N2B0001

To create a multiple input custom metric
1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Custom Metrics.

The Custom metric definitions screen opens.

3. Click Add.

The Custom metric type screen opens.

4. In the Select custom metric type list, select Multiple Input Metric.

5. Click Continue.

The Custom metric definition screen opens.

6. In the Name field, enter a name for the metric. The name is used internally.

The name must be a single word, with only alphanumeric characters, and the first
character must be a letter.

7. In the Title field, enter a title for the metric.

The title appears in lists of metrics. It is also the basis for the title of the column
containing the metric data.

8. In the Description field, enter a description for the metric.

The description is the explanation of the metric's column that appears in the page
help for the report.

9. From the Metric 1 list, select the first metric to combine.

If you are dividing metric values, Metric 1 is the number that is divided.

10. From the Metric 2 list, select the second metric to combine.

If you are dividing metric values, Metric 2 is the number that is divided by
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11. From the Operation list, select the operation you want to use to combine the two
metrics.

12. If you selected a floating point operation, select the number of decimal places to
use from the Precision list.

13. Check the Graphable field to have the data from this metric to be available for
graphing in the report graph.

14. Check the Display percentage of total field to have a percentage to display in the
column as well as a number.

15. From the Alignment list, select how the values are aligned in the report column.

The options are Center, Left, and Right.

16. In the Minimum twips field, enter the minimum number of twips for the metric's
column in reports.

A twip equals 1/1440 of an inch. This option only affects reports that are exported in
RTF format (usually for use in Microsoft Word).

17. In the Recommended twips field, enter the recommended number of twips for the
metric's column in reports.

Unica NetInsight tries to make the column the recommended width.

18. Click Continue.

The custom metric is now available on the Metrics page of the Custom Report
Wizard.

To make the custom metric available on the Discovery Panel, you must add it to a
group in one or more metrics lists.

N2C0001

To edit a custom filtered metric
If you are adding filter groups to the custom filtered metric, you must define the filter
group before performing this task.

1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Custom Metrics.

The Custom metric definitions screen opens.

3. Select the custom filtered metric to edit.

4. Click Edit.

The Custom metric type screen opens.

5. In the Title field, edit a title for the metric.

The title appears in lists of metrics. It is also the basis for the title of the column
containing the metric data.

6. In the Description field, edit a description for the metric.
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The description is the explanation of the metric’s column that appears in the page
help for the report.

7. From the Base metric list, select the metric that provides the data to be filtered for
the current metric.

8. Check the Graphable field to have the data from this metric to be available for
graphing in the report graph.

9. Check the Display percentage of total field to have a percentage to display in the
column as well as a number.

10. From the Alignment list, select how the values are aligned in the report column.

The options are Center, Left, and Right.

11. In the Minimum twips field, enter the minimum number of twips for the metric's
column in reports.

A twip equals 1/1440 of an inch. This option affects only reports that are exported in
RTF format (usually for use in Microsoft Word).

12. In the Recommended twips field, enter the recommended number of twips for the
metric's column in reports.

Unica NetInsight tries to make the column the recommended width.

13. Click Continue.

The Filters for . . screen opens.

14. Add one or more filters or filter groups to the custom metric as necessary.

a. Click Add.

The Available filters screen opens.

b. Select a dimension, or to add a defined filter group, select Filter Group.

c. Click Continue.

If you select a dimension, the Filter description screen opens.

If you select Filter Group, a list of defined filter groups open.

d. Complete the screen as required:

• If you selected a string dimension, select that or that do not from the first
list.

Then select a matching type from the second list.

Then enter a string in the field, or select a value from the Or select from
this menu list.

• If you selected a numeric dimension, select a value from the list.

• If you selected Filter Group, select the filter group to use.
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Click Add as Group to add the complete filter group, so you are not able to
remove individual filters from the custom metric. Or click Add as Filters to
add all filters from the group individually, so you can delete filters from the
custom metric.

e. Click Continue.

f. Repeat steps a through e until you have added all required filters.

g. Click Continue.

15. Edit filters or filter groups as necessary.

a. Select the filter or filter group to edit.

b. Click Edit.

If you select a dimension, the Filter description screen opens.

If you select Filter Group, a list of defined filter groups open.

c. Complete the screen as required:

• If you selected a string dimension, select that or that do not from the first
list.

Then select a matching type from the second list.

Then enter a string in the field, or select a value from the Or select from
this menu list.

• If you selected a numeric dimension, select a value from the list.

• If you selected Filter Group, select the filter group to use.

Click Add as Group to add the complete filter group, so you are not able to
remove individual filters from the custom metric. Or click Add as Filters to
add all filters from the group individually, so you can delete filters from the
custom metric.

d. Click Continue.

e. Repeat steps a through e until you have edited all required filters.

f. Click Continue.

16. Delete filters or filter groups as necessary.

a. Select the filter or filter group to delete.

b. Click Delete.

17. Click Continue.

The updated custom metric is now available on the Metrics page of the Custom
Report Wizard.

To make the custom metric available on the Discovery Panel, you must add it to a
group in one or more metrics lists.

N2D0001
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To edit a multiple input custom metric
1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Custom Metrics.

The Custom metric definitions screen opens.

3. Select the multiple input custom metric to edit.

4. Click Edit.

The Custom metric definition screen opens.

5. In the Title field, edit a title for the metric.

The title appears in lists of metrics. It is also the basis for the title of the column
containing the metric data.

6. In the Description field, edit the description for the metric.

The description is the explanation of the metric’s column that appears in the page
help for the report.

7. From the Metric 1 list, select the first metric to combine.

If you are dividing metric values, Metric 1 is the number that is divided.

8. From the Metric 2 list, select the second metric to combine.

If you are dividing metric values, Metric 2 is the number that is divided by

9. From the Operation list, select the operation you want to use to combine the two
metrics.

10. If you selected a floating point operation, select the number of decimal places to
use from the Precision list.

11. Check the Graphable field to have the data from this metric to be available for
graphing in the report graph.

12. Check the Display percentage of total field to have a percentage to display in the
column as well as a number.

13. From the Alignment list, select how the values are aligned in the report column.

The options are Center, Left, and Right.

14. In the Minimum twips field, enter the minimum number of twips for the metric's
column in reports.

A twip equals 1/1440 of an inch. This option only affects reports that are exported in
RTF format (usually for use in Microsoft Word).

15. In the Recommended twips field, enter the recommended number of twips for the
metric's column in reports.

Unica NetInsight tries to make the column the recommended width.
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16. Click Continue.

The custom metric is now available on the Metrics page of the Custom Report
Wizard.

To make the custom metric available on the Discovery Panel, you must add it to a
group in one or more metrics lists.

N2E0001

To delete a custom metric
1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Custom Metrics.

The Custom metric definitions screen opens.

3. Select the custom metric to delete.

4. Click Delete.

The Custom metric definition screen opens.

5. Click Continue.

The custom metric is no longer available.
N270001

Creating filter groups
■ About filter groups
■ To create a filter group
■ To edit a filter group
■ To edit filters for a filter group
■ To delete a filter group

N270009

About filter groups
When users create multiple reports, they may often need to apply the same filters
repeatedly. Filter groups enable you to specify a set of filters (including custom filters)
once and then apply it to many reports. When a user applies a filter group containing
multiple filters, the user can choose to apply the filter as a single group or as the
individual filters within the group. If the filters are applied as a group, the filters can only
be removed as a single unit. If the filters are added as individual filters, the user can
independently select and remove specific filters, while keeping others.

N2F0001

To create a filter group
1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Filter Groups.
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The Filter group definitions screen opens.

3. Click Add.

The Filter group description screen opens.

4. In the Name of filter group field, enter a one-word name.

The name is used internally. You can use only alphanumeric characters. Once the
filter group is created, you cannot change the name.

5. In the Title of filter group field, enter a title.

The title appears in the list of filters.

6. Click Save Options, then click Continue.

The Filters that belong to screen opens.

7. Add one or more filters or other filter groups to the filter group.

a. Click Add Filter.

The Available filters screen opens.

b. Select a dimension, or to add a defined filter group, select Filter Group.

c. Click Continue.

If you select a dimension, the Filter description screen opens.

If you select Filter Group, a list of defined filter groups open.

d. Complete the screen as required:

• If you selected a string dimension, select that or that do not from the first
list.

Then select a matching type from the second list.

Then enter a string in the field, or select a value from the Or select from
this menu list.

• If you selected a numeric dimension, select a value from the list.

• If you selected Filter Group, select the filter group to use.

Click Add as Group to add the complete filter group, so you are not able to
remove individual filters from the custom metric. Or click Add as Filters to
add all filters from the group individually, so you can delete filters from the
custom metric.

e. Click Continue.

f. Repeat steps a through e until you have added all required filters.

g. Click Save Filters.

8. Click Continue.

You must now apply the filter group to a report.
N300001
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To edit a filter group
These instructions describe how to change the filter group's title. You can also edit the
filters included with the filter group.

1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Filter Groups.

The Filter group definitions screen opens.

3. Select the filter group to edit.

4. Click Edit.

The Filter group description screen opens.

5. In the Title of filter group field, enter a title.

The title appears in the list of filters.

6. Click Save Options, then click Continue.
N310001

To edit filters for a filter group
1. While working with the profile, click Options.

2. In the left panel, under Reporting, click Filter Groups.

The Filter group definitions screen opens.

3. Select the filter group for which you want to edit filters.

4. Click Filters.

The Filters that belong to screen opens.

5. Add one or more filters or defined filter groups to the filter group as necessary.

a. Click Add Filter.

The Available filters screen opens.

b. Select a dimension, or to add a defined filter group, select Filter Group.

c. Click Continue.

If you select a dimension, the Filter description screen opens.

If you select Filter Group, a list of defined filter groups opens.

d. Complete the screen as required:

• If you selected a string dimension, select that or that do not from the first
list.

Then select a matching type from the second list.

Then enter a string in the field, or select a value from the Or select from
this menu list.
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• If you selected a numeric dimension, select a value from the list.

• If you selected Filter Group, select the filter group to use.

Click Add as Group to add the complete filter group, so you are not able to
remove individual filters from the custom metric. Or click Add as Filters to
add all filters from the group individually, so you can delete filters from the
custom metric.

e. Click Continue.

f. Repeat steps a through e until you have added all required filters.

g. Click Continue.

6. Edit filters or filter groups as necessary.

a. Select the filter or filter group to edit.

b. Click Edit Filter.

If you select a dimension, the Filter description screen opens.

If you select Filter Group, a list of defined filter groups opens.

c. Complete the screen as required:

• If you selected a string dimension, select that or that do not from the first
list.

Then select a matching type from the second list.

Then enter a string in the field, or select a value from the Or select from
this menu list.

• If you selected a numeric dimension, select a value from the list.

• If you selected Filter Group, select the filter group to use.

Click Add as Group to add the complete filter group, so you are not able to
remove individual filters from the custom metric. Or click Add as Filters to
add all filters from the group individually, so you can delete filters from the
custom metric.

d. Click Continue.

e. Repeat steps a through e until you have edited all required filters.

f. Click Continue.

7. Delete filters or filter groups as necessary.

a. Select the filter or filter group to delete.

b. Click Delete Filter.

8. Click Back to Filter Groups.
N320001
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To delete a filter group
Deleting a filter group impacts all reports and custom metrics to which you added the
filter group as a group, as well as any saved reports that use the report or custom
metric.

1. While working with the profile, click Options.

2. In the Options panel, select Reporting > Filter Groups.

The Filter group definitions screen opens.

3. Select the filter group to delete.

4. Click Delete.

The Filter group description screen opens.

5. Click Continue.
N280001

Specifying a sample size
■ About data samples
■ To specify the sample size
■ Permissions for sampling features

N280007

About data samples
You can allow users to work with reports that display projections based on a random
sample of the profile data. Working with a profile's full data set may be more
time-consuming than is practical for ad-hoc analysis. Some tasks, such as exploring
data or creating reports, can be accomplished more quickly using a subset of the data
with the calculations extrapolated to the full data set. You can enable the sample
reporting mode by specifying a non-zero sample size in the profile options. The sample
size is defined as a percentage of visitors.

When a profile with a non-zero sample size specified is updated, Unica NetInsight does
the following:

• Takes a random sample of the specified size of all new visitors in the data imported
during this update and stores all data associated with these visitors in sample tables
in the profile's database. For example, if the sample size were 5% and there were
100 new visitors imported during the update, Unica NetInsight would randomly
select 5 of the new visitors and store their data in the sample tables.

• Looks for any new visits by visitors already in the sample and adds information
about those visits to the sample tables.

Spider and robot visitors also are sampled at the specified percentage.
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After you specify a profile's visitor sample percentage for the first time, update the
profile to make sample reports available. If you are changing an existing non-zero
sample percentage, run the - resample command-line option followed by the
-recalc -sampleonly command-line option to update the sample tables and reports.

About the sample size
The sample size is defined as a percentage of visitors in the full data set. You may
enter a numeric value between 0 and 100 with precision up to three decimal places to
the right of the decimal point. If you know you want the sample of visitors to include a
specific count of a certain database entity (such as visits, events, or views), you can use
the -samplecalc command-line option to estimate the percentage of visitors to use to
return a sample with the desired entity count.

Changing the sample size
Each time you change the visitor sample percentage option, you should clear the
sample tables and resample the profile data. You can do this without disturbing your
non-sample tables by running the -resample command-line option followed by the
-recalc -sampleonly option. If you do not run -resample, when you update the
profile, new data is sampled at the new percentage. This results in a sample set that
contains the previous percentage of old data and the new percentage of new data. You
can fix this by running -resample followed by -recalc -sampleonly.

Changing the sample data
You can also change the data in the sample while leaving the sample size the same.
Unica NetInsight uses a random number generator to select new visitors for the sample.
The random number generator algorithm is determined by a seed value. A given seed
selects the same set of visitors every time from a fixed set of data. If you would like to
see a different sample, run the -reseed command-line option to change the seed and
then run the -resample command-line option to clear and repopulate the sample
tables followed by the -recalc -sampleonly option to generate the reports.

N330001

To specify the sample size
1. View the profile.

2. Click the Options tab.

3. Under Reporting, click Sampling.

The Sampling options screen appears.

4. In the Visitor sample percentage field, enter the percentage of visitors in the full
data set you want in the sample.

You can specify up to three decimal places to the right of the decimal point. Use a
value of zero to disable sampling (not generate any sample tables or reports).

5. Click Save Options.
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If this is the first time a sample size has been entered for the profile, you must update
the profile before users can select a reporting mode. If you have changed an existing
sample value, you must run the -resample command-line option followed by the
-recalc -sampleonly option to use the new sample size. Any previous sample data
is used until the profile is resampled.

N340001

Permissions for sampling features
You can prevent users from changing the sample size through the interface. You can
also remove the Reporting Mode option to prevent users from changing the reporting
mode and limit them to their default mode for each profile. You can also prevent users
from saving reports to be automatically generated in Full mode or Sample mode.

The following new privileges have been added to control access to sampling:

Privilege Option

Options: Reporting: Sampling Visitor sample percentage option

Interface: Icon: Reporting Mode Reporting Mode option on Reports and Custom
tabs

Interface: Sampling: Email/Export Change Level Reporting mode option on Email and Export
options screens

Interface: Custom Report Wizard: Auto Update Automatically update sample report option
Sample Report

Interface: Custom Report Wizard: Auto Update Automatically update full report option
Full Report
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5 Analyzingevents

■ About events
■ Configuring Unica NetInsight to track events
■ To define an event title
■ To edit an event title
■ To delete an event title

N350001

About events
An event is any action on your Web site other than loading a page. Events include, but
are not limited to, the following:

• Changing a field on a form

• Selecting an option in a drop-down list box

• Submitting a form

Events are plentiful in Rich Internet Applications (RIAs) such as Flash or AJAX
presentations.

N360001

Configuring Unica NetInsight to track
events

Before you can analyze events in Unica NetInsight, you must first tag the events on
your site using Unica page tags and configure the Unica NetInsight profile to analyze
page tags. See the Unica Page Tags User's Guide for details on tagging pages.

Any page tag request that contains the optional name-value pair ev=value will be
considered an event by Unica NetInsight and will appear in the Event Summary.

N370001
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To define an event title
By default, an event will be listed in a report using the value for the ev field that appears
in the page tag request. Statistics for all events with the same value will appear in the
same row of the report. You can specify a more user-friendly title for an event that will
display in the reports instead of the request value.

1. View the profile in which you want to analyze events.

2. Click the Options tab.

3. In the Options panel, select Dynamic Content > Events.

4. Click Add.

5. In the Value of event field box, enter the value used for the ev field in the page tag
requests for this event.

6. In the Title of event box, enter the text you want to appear in the report instead of
the event field value.

7. Check the Create filtered metric check box if you want Unica NetInsight to create a
filtered metric based on this event.

8. Click Save Options and then click Continue.

Unica NetInsight will begin using the new event titles the next time reports are
generated.

N380001

To edit an event title
1. View the profile that contains the event title you want to edit.

2. Click the Options tab.

3. In the Options panel, select Dynamic Content > Events.

4. Select the event title and click Edit.
N390001

To delete an event title
When you delete the event title for an event, Unica NetInsight will use the event field
value in reports.

Filtered metrics based on events cannot be deleted from the Events option pages. You
must delete the custom metrics from the Custom Metrics option pages.

1. View the profile that contains the event whose title you want to delete.

2. Click the Options tab.

3. In the Options panel, select Dynamic Content > Events.

4. Select the event title you want to delete and click Delete.
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6 Analyzing content
groups

■ About analyzing content groups
■ About determining the content group for files that fit multiple groups
■ To create a content group

N3A0001

About analyzing content groups
Unica NetInsight lets you track the popularity of different types of content on your Web
site. For example, you could track how many visitors are viewing information on
particular products.

To track different types of content, you need to divide the files that contain the content
for your Web site into content groups. The content group statistics appear on the
Content Summary.

N3B0001

About determining the content group for
files that fit multiple groups

A file can only belong to one content group. If you have a file that meets the criteria for
more than one group, Unica NetInsight will include the file in the first content group to
which it can belong. You can use the Move Up and Move Down buttons to change the
order of the content groups in the Content groups to be analyzed list.

N3C0001

To create a content group
1. View the profile in which you want to create the content group.
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2. Click the Options tab.

3. In the Options panel, select Content > Content Groups.

4. Click Add.

5. Enter a name for the content group, click Save Options and then click Continue.

6. Select the content group and click Pages.

7. Click Add.

8. Enter a filter that describes the files you want to include in this content group.

9. Click Add.

Your content group statistics will be tracked for all new data you import from now on.

10. If this is what you want or if you have additional filters or content groups to enter at
this time, click Continue.

If you want to analyze this content group in data you have already imported, you will
need to delete all the data in your profile and reimport your log files.

If you do not still have all the log files you have imported into this profile, you will
lose data permanently by choosing this option.

To delete your profile data, click Delete Profile Data.

11. To add another filter to this content group, click Add. To return to the list of content
groups, click Back to Content Groups.
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7 Analyzing Marketing
Efforts

■ About analyzing marketing efforts
■ Analyzing campaigns
■ Analyzing visit cost

N3D0001

About analyzing marketing efforts
Unica NetInsight allows you to track the effectiveness of the marketing efforts that relate
to your Web site. Using Unica NetInsight you can:

• Analyze the performance of various campaigns

• Analyze visit cost and paid search ROI

• See which sites are referring the most visitors to your site

• Track which search engines and directories are indexing your site
N3E0001

Analyzing campaigns
■ About campaigns
■ About dynamic and static campaigns
■ About campaign channels
■ About campaign segments
■ About entry pages for campaign segments
■ To create a campaign in NetInsight
■ To specify campaign channels
■ To specify campaign segments
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■ To specify entry pages
■ About paid search data

N3E0009

About campaigns
A campaign is messaging created by a marketing department to drive traffic to your
Web site. A campaign is typically run through multiple channels (banner ads, email,
Internet search, print ads, etc.) and a channel may contain multiple segments (the ad
variation within a channel). Optionally, a campaign can include specific entry pages on
your Web site that associate a visit with that campaign. In Unica NetInsight, campaign
statistics are listed in the Campaign Summary report.

The following diagram shows the relationships between campaigns, channels,
segments, and paid keywords in two sample static campaigns.

N400001
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About dynamic and static campaigns
Campaigns can be defined in Unica NetInsight as either dynamic or static.

• Dynamic campaigns attribute visits based on parameter values passed in a query
string.

• Static campaigns attribute visits based on entry page definitions in the campaign's
channel segments.

About dynamic campaigns
Dynamic campaigns allow you to define a campaign matching pattern only once in
Unica NetInsight, instead of having to define each campaign manually. This is
especially useful with online channels whose channel and segment definitions may alter
regularly over time.

You create dynamic campaigns by specifying a campaign parameter identifier in Unica
NetInsight. This identifier is used to match a campaign parameter identifier in the URLs
visitors use to access your site. At data import, Unica NetInsight parses the parameter
strings in your site logs. When a match is made between a query string parameter ID
and one defined in Unica NetInsight, Unica NetInsight examines the value of the
parameter. It then attributes that visit to an existing campaign (if a value match is found)
or automatically creates and assigns that visit to a new campaign (if a value match is
not found). The name of each campaign in Unica NetInsight is the value of the
parameter.

The channels and segments belonging to a campaign can also be defined as dynamic,
thus you can use a single campaign, channel, and segment matching pattern to process
all visit attributions to your campaigns. While dynamic campaigns can use parameter
values alone to attribute visits, you can include entry page definitions as well if you want
target specific pages only in a campaign.

For example, suppose you define a dynamic campaign whose parameter identifier is
camp. Under that you define a dynamic channel whose parameter identifier is chan.
And under that you define a dynamic segment whose parameter identifier is seg. Three
unique visitors enter your site at these URLs:

• http://www.mysite.com?&camp=Clearance&chan=Email&seg=SpecialOf

fer

• http://www.mysite.com?&camp=Clearance&chan=Twitter&seg=Special

Offer

• http://www.mysite.com?&camp=SpringSale&chan=Email&seg=SaleAler

t

The first two visits will both be attributed to the Clearance campaign, different channels,
but to the same SpecialOffer segment. The third visit will be attributed to the SpringSale
campaign, Email channel, and SaleAlert segment. If any of these campaigns, channels,
or segments do not already exist in Unica NetInsight they will be created automatically.

In Unica NetInsight reports, in addition to comparing the traffic generated by the two
campaigns, you can also compare traffic generated across campaigns by different
channels (Email versus Twitter) and segments (SpecialOffer versus SaleAlert).
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About Static campaigns
Static campaigns attribute visits based on entry page definitions in the campaign's
channel segments. While less flexible than dynamic campaigns, static campaigns are
useful if you are not parameterizing URLs, or if you deploy only a few campaigns whose
channels and segments alter little or not at all over time. Static campaigns could be a
good choice for print media, since you know the URL well in advance of the traffic
coming to your site.

For example, suppose you were running several magazine ads to launch a new
product. The campaign segment for the first ad might look like this:

Campaign Name: Extreme Widget

Channel Name: Print Media

Segment Name: Ad1

Entry Page: www.site.com/ExtremeWidgetAd1

51

Every visit whose entry page is www.site.com/NewProductAd1 will be associated
with the Ad1 segment of the Extreme Widget campaign.

Which to use, dynamic or static?
For most situations dynamic campaigns are superior to static. They are easier to set up,
more adaptive to change, and much easier to maintain. In static campaigns, each time
new channels segments are added to your marketing campaign they must be manually
added to Unica NetInsight. Dynamic campaigns automate this process and require
editing only if parameter identifiers themselves change.

A simple deployment model would be to create a single dynamic campaign with
dynamic channels and segments. If you want the ability to compare campaign-driven
visits to organics visits, below the dynamic camapign you could create a single static
campaign with static channels and segments and no entry pages. This static campaign
would catch any and all visits not matched and attributed by the dynamic campaign.

Note that as it suits your needs you can also use a hybrid of static and dynamic
behavior at different levels in a campaign definition. For example, you could create a
static campaign whose channels and segments are dynamic.

Ordering campaigns for desired attribution
A visit can be attributed to only one campaign. If a visit meets the criteria for multiple
campaigns, Unica NetInsight attributes it to the first campaign whose criteria it meets.
The order of attribution is determined by the order in which campaigns are listed on the
Campaign Options screen.

It is important to consider the order in which you want visits attributed and then order
your campaigns accordingly. As a rule of thumb, you should position campaigns with
the most-specific matching criteria at the top. A static campaign with static channels and
segments and no entry page definition will match all visits. If such a campaign were
positioned at the top of the list no other campaigns would receive attribution. Use the up
and down buttons to the right of the list to change the order of the campaigns.
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These ordering considerations and guidelines apply to channels and segments as
well.

Allowing default substitutions for dynamic channels and
segments
When you create dynamic channels and segments, you can specify whether to allow a
default value to be used if the parameter identifier specified in Unica NetInsight is not
found in the parameter string, or if a parameter value is an empty string.

• If you allow the default to be used, "None" will be substituted for missing parameter
identifiers and/or values.

• If you do not allow the default to be used, Unica NetInsight will search other
channels and campaigns and attempt to make a parameter identifier match. If a
match is made, attribution for that visit is assigned accordingly. If a match cannot be
made, no visit attribution is assigned. If the parameter value is missing, no
attribution is made.

N410001

About campaign channels
A campaign channel is the content source (such as a Web site, print publication, or
newsletter) through which you are running a campaign that sends visitors to your Web
site. Campaign channel statistics appear on the Campaign Channel Summary.

If campaign channels in separate campaigns share a name, you can analyze the
combined traffic for the channels in the Campaign Channel Summary. In the Campaign
Channel Summary unfiltered by a campaign, there is one row per unique channel name
that shows the combined traffic for all channels with that name. In the Campaign
Channel Summary filtered by a campaign, the row with the shared channel name shows
only traffic for the channel in the specified campaign.

You must specify one of the following types for each campaign channel:

• Affiliate — Web site that sells the products of other Web sites, called "affiliates."

• Banner ad — Advertisement in the form of a graphic image on a Web page or
located in a space reserved for ads, linking to an advertiser’s Web site.

• Direct mail — Marketing communications delivered directly to a prospective
purchaser via a postal service or private delivery company.

• Email — Email message that contains information or advertising.

• Instant messaging — Service that alerts users when friends or colleagues are
online, and enables them to communicate in real time through private online chat
areas.

• Newsletter — Printed or online report that provides news or information of interest to
a special group.

• Paid listing — Guarantee of a ranking in a search listing for the terms of your
choice; can be placed on a site other than a search engine.
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• Print media — Medium that distributes printed matter, such as a newspaper,
magazine, or book.

• Rich media ad — Advertisement that usually includes richer graphics than a banner
ad and includes audio or video within the advertisement.

• Search engine (PPC/CPM) — Pay-per-click or cost per thousand views advertising
(or both) on a search engine.

• (Other) — A channel type not listed above.

Campaign channel type statistics appear on the Campaign Channel Type Summary.

For search engine (PPC/CPM) channels, you can analyze the performance of the
various paid keywords. Paid keyword statistics appear on the Paid Keyword Summary.

N420001

About campaign segments
A campaign segment is the ad variation or group within each campaign channel.
Campaign segment statistics appear on the Campaign Segment Summary. Like
campaigns and channels, segments can be dynamic or static.

Optionally, segments can have one or more associated entry pages. Entry pages can
be defined using the page's file name or by a query string filter. Visitors who access a
site via a segment's defined entry pages will be attributed to that segment, and their visit
will ultimately be attributed to the segment's campaign. While Unica NetInsight does not
require you to define entry pages, whether you should or not depends on the type of
campaign you are creating and whether you want only select entry pages attributed to
your campaigns.

• Dynamic campaigns (with dynamic channels and segments) can attribute visits to
campaigns based on parameter strings alone. Define entry pages only if you want
specific points of entry attributed to your dynamic campaign.

• Static campaigns (with static channels and segments) can only attribute visits based
on entry page. So, while not required by Unica NetInsight, practically speaking,
static campaigns require entry page definitions if they are to accurately attribute
visits to different campaigns. A static campaign with no entry pages defined will
match every visit to your site.

If campaign segments in separate channels share a name, you can analyze the
combined traffic for the segments in the Campaign Segment Summary. In the
Campaign Segment Summary unfiltered by a channel, there is one row per unique
segment name that shows the combined traffic for all segments with that name. In the
Campaign Segment Summary filtered by a channel, the row with the shared segment
name shows only traffic for the segment in the specified channel.

N430001

About entry pages for campaign segments
For any campaign segment you can specify the URL of an entry page to your Web site.
Visitors arriving on this page will be attributed to this segment.

Version 8.1.5 53



7 - Analyzing Marketing Efforts

URLs for entry pages must be unique for each segment. You can achieve unique URLs
in the following ways:

• Create a separate entry page for each campaign segment.

• Use query string parameters to create multiple unique URLs for the same entry
page.

Do not use your home page as the entry page unless you are using query strings to
define the entry page. If you are not using query strings and you use your home page
as the entry page for the campaign, all traffic to your home page appears in the
campaign analysis. To figure out what percentage of the traffic to your home page
resulted from your campaign, you must drill repeatedly into the Campaign Summary.

Query strings can contain other parameters besides the ones used to identify the
campaign segment. These parameters can be analyzed in Unica NetInsight as well.

About entry page matching rules
Unica NetInsight applies entry page matching rules defined for a campaign segment as
follows:

• If a question mark is not present in the value specified for the entry page rule, the
entire value that is specified is compared to the entry page according to the rule
definition.

• If a question mark is present in the value specified for the entry page rule, the part
of the rule to the left of the question mark (the page portion) is compared to the
entry page according to the rule definition. If the page part of the rule matches, the
part to the right of the question mark (the query string portion) is compared to the
query string associated with the entry page as follows:

• If the first character of the query string part of the rule is a percent sign, it will be
considered to be a regular expression and will be compared to the query string
part of the entry page using a that match the regular expression filter.

• If the first character of the query string part of the rule is not a percent sign and
the query string part of the rule contains one or more equal signs, it will be
considered to be a collection of name/value pairs that Unica NetInsight should
search for in the query string associated with the entry page. The query string
part of the entry page will be considered a match if each name/value pair
present in the rule definition is also present in the query string. The order and
case of the name/value pairs entered in the rule definition is not significant.

• If the first character of the query string part of the rule is not a percent sign and
the query string part of the rule does not contain an equal sign, it will be
compared to the query string part of the entry page using a that match filter.

Following are some examples of entry page rules and the pages that will and will not
match the rule.
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Example 1
If the entry pages of a campaign segment are defined by the filter that contain ad?
%referrer=google.*, visitors entering the Web site through the following pages would
be attributed to the given campaign, channel, and segment:/ad.cgi?referrer=google
/ad.cgi?thereferrer=google /ad.cgi?keywords=red&referrer=google
/scripts/ad.cgi?referrer=google&keywords=red
/googlead.cgi?referrer=google-groups&keywords=red

Visitors entering through these entry pages would not be attributed to the given
campaign, channel, and segment:/ad.cgi?referrer=yahoo /referral.cgi?referrer=google

Example 2
If the entry pages of a campaign are defined by the filter that match
/ad.cgi?referrer=google, visitors entering the Web site through the following pages
would be attributed to the given campaign, channel, and
segment:/ad.cgi?referrer=google /ad.cgi?referrer=google&keywords=red
/ad.cgi?keywords=red&referrer=google

Visitors entering through these pages would not be attributed to the given campaign,
channel, and segment:/ad.cgi?referrer=google-groups /ad.cgi?thereferrer=google

Example 3
If the entry pages of a campaign are defined by the filter that end with ad.cgi?google,
visitors entering the Web site through the following page would be attributed to the
given campaign, channel, and segment:/ad.cgi?google

Visitors entering through these pages would not be attributed to the given campaign,
channel, and segment:/ad.cgi?google-groups /scripts/ad.cgi?referrer=google

N440001

To create a campaign in NetInsight
1. View the profile in which you want to create a campaign.

2. Click the Options tab.

3. Under Options select Marketing > Campaigns.

4. Click Add.

5. Enter a name for the campaign.

In static campaigns, this is the name that will appear in reports. In dynamic
campaigns, the campaign name in reports is the value returned by the campaign
parameter.

6. Specify whether the campaign is static or dynamic.

7. Enter the parameter whose value will be used to define unique campaigns. The
parameter ID is case-insensitive.

8. Click Save Options > Continue.
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Next you must specify the channels through which you are running this campaign.
N450001

To specify campaign channels
If you are specifying channels for a campaign immediately after creating the campaign,
begin with step 4 below. Otherwise, begin with step 1.

1. View the profile that contains the campaign for which you are defining channels.

2. Click the Options tab.

3. Under Options select Marketing > Campaigns.

4. Select the campaign and click Channels > Add.

5. Enter a name for the channel.

In static channels, this is the name that will appear in reports. In dynamic channels,
the channel name in reports is the value returned by the channel parameter.

6. Select the channel type that best describes the content source through which you
are running this campaign. If you select:

a. Search engine (PPC/CPM), enter the parameter from which paid keywords will
be parsed. The parameter ID is case-insensitive.

b. Other, enter a description of the channel type.

7. Specify whether this channel is static or dynamic. For dynamic channels:

a. Enter the parameter whose value will be used to define channels in this
campaign. The parameter ID is case-insensitive.

b. Specify whether to assign a visit to the default channel "None" if the parameter
identifier is not found in a parameter string. If left unchecked, Unica NetInsight
will search other campaigns and attempt to make a match for attribution.

8. Click Save Options > Continue.

Next you must specify the campaign segments for this campaign channel.
N460001

To specify campaign segments
If you are specifying segments for a campaign channel immediately after creating the
channel, begin with step 4 below. Otherwise, begin with step 1.

1. View the profile that contains the campaign for which you are defining segments.

2. Click the Options tab.

3. Under Options select Marketing > Campaigns.

4. Select the campaign and click Channels.

5. Select the channel and click Segments > Add.

6. Enter a name for the segment.
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In static segments, this is the name that will appear in reports. In dynamic
segments, the segment name in reports is the value returned by the segment
parameter.

7. Specify whether this channel is static or dynamic. For dynamic channels:

a. Enter the parameter whose value will be used to define segments in this
channel. The parameter ID is case-insensitive.

b. Specify whether to assign a visit to the default segment "None" if the parameter
identifier is not found in a parameter string. If left unchecked, Unica NetInsight
will search other channels and attempt to make a match for attribution.

8. Click Save Options > Continue.

Next, you can optionally specify entry pages associated with this campaign segment. If
you choose not to specify entry pages for a dynamic campaign, Unica NetInsight will
use parameter values alone to attribute visits to the campaign. Note if you choose not to
specify entry pages for a static campaign, all visits will be attributed to the segment's
campaign.

N470001

To specify entry pages
If you are specifying entry pages for a campaign segment immediately after creating the
segment, begin with step 6 below. Otherwise, begin with step 1.

Specifying an entry page is an optional step in defining a NetInsight campaign. If
you choose not to specify entry pages for a dynamic campaign, NetInsight will use
parameter values alone to attribute visits to the campaign. If you choose not to
specify entry pages for a static campaign, all visits will be attributed to this the
campaign.

1. View the profile that contains the campaign for which you are defining entry pages.

2. Click the Options tab.

3. Under Options select Marketing > Campaigns.

4. Select the campaign and click Channels.

5. Select the channel and click Segments.

6. Select the segment and click Entry Pages > Add.

7. Enter a filter that specifies the page(s) visitors responding to your campaign use to
access your site.

For example, if you are tracking a banner ad campaign, specify the page visitors go
to after clicking the ad. If you are tracking a print ad campaign, specify the Web site
address given in the print ad. You can also use query strings to define your
campaign.

8. Click Add.
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Statistics for this campaign will now be tracked in all subsequently imported data. To
track this campaign in data that has already been imported you must delete your profile
data and re-import the log files. Note that if you no longer have all previously imported
log files, deleting profile data will result in data loss.

N480001

About paid search data
■ About paid search data
■ To analyze paid search data
■ Creating paid search campaigns to analyze in Unica NetInsight
■ Creating a paid search campaign in Unica NetInsight

N480007

About paid search data
If you bid on paid search terms at one or more search engines, you can configure a
campaign in Unica NetInsight to analyze traffic driven to your site by paid search terms.
This enables you to analyze activity on a search term across search engines and
attribute future activity on your site to the paid search terms.

For supported search engines, you can configure the profile to use the paid search
integration module to integrate data from the search engines into the Unica NetInsight
campaign summaries. This enables you to analyze cost, rank, and impressions for the
search terms, as well as number of visitors and visitors' behavior on your site.

About paid search integration module data
Your Unica NetInsight license must be enabled for the paid search integration module
before you can use the integration module data.

Once your profile is configured to use the paid search integration module, the paid
search data is imported during your normally scheduled data import for the profile.
Because search engines release the paid search data at the end of each day, it may
take a day or two for the data to appear in your profile, depending on when you update
your profile. If you want to see the paid search data sooner, you can update your profile
more frequently.

If your password for one of the search engines changes, you must contact Unica to
ensure the paid search integration module continues to have access to your paid
search data.

The paid search integration brings the following data into Unica NetInsight:

• Match type

• Clickthroughs

• Cost

• Impressions

• Average rank

You can integrate data from the following search engines:
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• Google AdWords

• Yahoo Search Marketing

• Microsoft adCenter

About paid search integration reports and components
When a profile is configured to use the paid search integration module, Unica NetInsight
creates a separate version of the campaign-related summaries for paid search
integration. For example, you have a Campaign Channel Summary and a Paid Search
Campaign Channel Summary. The paid search reports include the paid search-specific
metrics. Paid search-specific dimensions, metrics, and filters are also available for use
on other reports.

Due to Unica NetInsight's sessionization methods, the Paid Search Clicks metric value
and the Visits metric value might not be the same for a given row in the report. The Paid
Search Clicks value shows the number of times someone clicked a search result to
come to your site. The Visits metric shows the number of discrete visits to your site. If a
visitor clicks through to your site multiple times before the specified number of minutes
between sessions has elapsed, the visitor would count for multiple paid search clicks
but only one visit.

N490001

To analyze paid search data
If you want to use the paid search integration module, contact Unica technical support
to ensure your Unica NetInsight license is enabled for paid search integration.

To analyze paid search data in Unica NetInsight, you must complete the following tasks:

1. Create a paid search campaign at one or more of the supported search engines.

2. Create one or more paid search campaigns in Unica NetInsight.

If you are not using the paid search integration module, go to the last step now.

3. Contact Unica technical support to provide your sign in information for each search
engine at which you have created a campaign.

Once your paid search integration account is set up, your Unica representative
provides you with your account user name and password for the paid search
module.

4. Configure the profile to use the paid search integration module.

You must have the permission for editing integration modules.

5. Update the profile.

The paid search data may not be immediately available.
N4A0001

Creating paid search campaigns to analyze in Unica NetInsight
Analyzing your paid search campaigns in Unica NetInsight is easier and more robust if
you consider the following issues when you configure your campaigns in the search
engines.
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Campaign and ad group names
You must create a campaign in Unica NetInsight that matches the campaign you create
in the search engine, so make note of the campaign and ad group names you use in
the search engine. You need to enter this exact text when creating the Unica NetInsight
campaigns.

Paid search campaign
You need to specify the paid keyword parameter you use in the search engine. We
recommend using the same parameter for all campaigns in a given search engine, and
separate parameters for each search engine. For example, you could use the following
keywords.

Search engine Keyword

Google gpkw

MSN mpkw

Yahoo ypkw

Configuring campaigns for analysis across search engines
To analyze the performance of specific search terms across search engines, you must
define the campaigns exactly the same in all the search engines.

Defining the destination URL
Unica NetInsight needs the destination URL to be unique for each ad group. (Each ad
group is a campaign segment in Unica NetInsight.) If you don’t want to create a
separate web page for each ad group, you can make the URLs unique by using query
string parameters.

You can also use other query string parameters to enable Unica NetInsight to analyze
additional information about your paid search campaigns.

For example, suppose you entered the following destination URL for an ad group in
Google:

http://www.unicaware.com/ads.htm?adgroup=colorcopiers&keyword={keyword}&variatio
n=2

The query string contains the following information:

• Ad group

• Keyword (Google replaces {keyword} with the keyword the user entered)

• Ad variation

Define the campaign segment using the entry page definition that contain
ads.htm?adgroup=colorcopiers.

If you define the variation parameter in Unica NetInsight, you can analyze the values in
reports.
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N4B0001

Creating a paid search campaign in Unica NetInsight
When you create a paid search campaign in Unica NetInsight, the text you enter in
certain fields must match exactly the text you entered when you created the campaigns
in the search engines. (If you are using the paid search integration module in Unica
NetInsight, the text must match exactly.)

Unica NetInsight campaign field Value

Name of campaign Name of the search engine campaign

Name of campaign channel Name of the search engine. Must be one of the
following: Google, Yahoo, MSN.

Type of channel Search engine (PPC/CPM)

Paid keyword parameter Keyword parameter you specified in the search
engine

Name of campaign segment Name of the ad group in the search engine

Group entry pages Destination URL for the ad the in the search
engine

N3F0001

Analyzing visit cost
■ About visit cost
■ About collecting visit cost data
■ About including visit cost data in Unica NetInsight reports

N3F0009

About visit cost
Visit cost is the amount of advertising money spent to drive a visitor to your site for a
particular visit.

N4C0001

About collecting visit cost data
Visit cost data is not contained in log files by default. If you want Unica NetInsight to
report on and analyze visit cost data, you will need to do one of two things:

• Configure your Web site to use page tags and pass the visit cost data in the page
tag image request using the name-value pair vc=value. (For details, see the Unica
Page Tags User’s Guide.) Then, configure your Unica NetInsight profile to use page
tags.
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• Import visit cost data into the Visit Cost table in the NetInsight database. (For details
on the Visit Cost table, see the Unica NetInsight Database Schema.)

N4D0001

About including visit cost data in Unica
NetInsight reports
The Cost metric and Average Cost metric report on visit cost data. These metrics are
available on the Discovery Panel and in the Custom Report Wizard and can be added
to any report.
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8 Analyzing Visitor
Profiles

■ About analyzing visitor profiles
■ To create a visitor profile
■ About changing the order of visitor profiles

N4E0001

About analyzing visitor profiles
Unica NetInsight enables you to track how often the members of various visitor profiles
are coming to your Web site. A visitor profile is a group of visitors that you have defined
on the Visitor Profile page of your Web server profile. You can sort visitors into groups
based on any of a large number of filters, including visit type (repeat or new), visit
duration, pages viewed, initial referrer, or content group.

A visit is considered a member of every profile whose filters it matches. Visitor profiles
can be used to gain a deeper understanding of exactly how visitors arrive at your site
and what interests them most during a visit.

Visitor profile statistics appear on the Visitor Profile Summary.

Visitor profiles are used in scenario reports to track visitor behavior across multiple
visits.

N4F0001

To create a visitor profile
1. View the profile in which you want to create a visitor profile.

2. Click the Options tab.

3. In the Options panel, select Visitors > Visitor Profiles.

4. Click Add.
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5. Enter a name for the profile.

6. Click Save Options and then click Continue.

7. Select the visitor profile and click Visitors.

8. Click Add Filter.

9. Select a filter type from the list and click Continue.

10. Enter the values for the filter.

11. Click Continue.

12. Repeat 8 through 11 until you have entered all the filters you want for the visitor
profile.

13. Click Save Filters and then click Continue.

You cannot add a filter group that contains a visitor profile to a visitor profile.
Your visitor profiles will be in effect the next time you run an update.

N500001

About changing the order of visitor profiles
You can use the Move Up and Move Down buttons to change the order of the visitor
profiles in the list. However, unlike some other options, changing the order has no affect
on the reports.
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9 CustomizingNetInsight

■ About Customizing Unica NetInsight
■ Working with views
■ Customizing the NetInsight interface
■ Working with report lists
■ Working with metric lists
■ Working with dimension lists
■ Working with filter lists

N510001

About Customizing Unica NetInsight
This section explains how to customize elements of the profile view, including
dimension, filter, and metric lists in Unica NetInsight.

N520001

Working with views
■ To create a profile view
■ To edit a profile view
■ To copy a profile view
■ To delete a profile view
■ To change to another profile view
■ About accessing a profile view through a URL

N520009

To create a profile view
Before you create a profile view, you need to create the dimension list, filter list, metric
list, and report list you want to use.

1. While working with the profile, click Options.
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2. In the left panel, under Interface, click Views.

The View definitions screen opens.

3. Click Add.

The View description screen opens.

4. In the Name of view (one word) field, enter a name for the view.

The name is used both internally and as a shortcut to access the view directly from
a browser. You may use only alphanumeric characters and hyphens, and the first
character must be a letter. Once the view is created, you cannot change the name.

5. In the Title of view field, enter a title for the view.

The title appears in the list of views.

6. From the Time period list, select the time period to be used by the calendar when
you first open Unica NetInsight .

7. From the Report list list, select the report list to use for the view.

8. From the Dimension list list, select the dimension list to use for the view.

9. From the Filter list list, select the filter list to use for the view.

10. From the Metric list list, select the metric list to use for the view.

11. Click Save Options, then click Continue.
N580001

To edit a profile view
1. While working with the profile, click Options.

2. In the left panel, under Interface, click Views.

The View definitions screen opens.

3. Select the view to edit.

4. Click Edit.

The View description screen opens.

5. In the Title of view field, enter a title for the view.

The title appears in the list of views.

6. From the Time period list, select the time period to be used by the calendar when
you first open Unica NetInsight .

7. From the Report list list, select the report list to use for the view.

8. From the Dimension list list, select the dimension list to use for the view.

9. From the Filter list list, select the filter list to use for the view.

10. From the Metric list list, select the metric list to use for the view.

11. Click Save Options, then click Continue.
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N590001

To copy a profile view
You can copy an existing profile view to create a new one. This may save time as all
settings are copied to the new view.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Views.

The View definitions screen opens.

3. Select the view to copy.

4. Click Copy.

The View description screen opens.

5. In the Title of view field, enter a title for the view.

The title appears in the list of views.

6. From the Time period list, select the time period to be used by the calendar when
you first open Unica NetInsight .

7. From the Report list list, select the report list to use for the view.

8. From the Dimension list list, select the dimension list to use for the view.

9. From the Filter list list, select the filter list to use for the view.

10. From the Metric list list, select the metric list to use for the view.

11. Click Save Options, then click Continue.
N5A0001

To delete a profile view
1. While working with the profile, click Options.

2. In the left panel, under Interface, click Views.

The View definitions screen opens.

3. Select the view to delete.

4. Click Delete.

5. Click Continue.
N5B0001

To change to another profile view
If aprofile contains multiple views and if you have permission to change your view, you
can change views from within the application interface. For example, you can change
from the complete profile view (a predefined view that contains all available dimensions,
filters, metrics, and reports) to a view that contains a subset of available dimensions,
filters, metrics, and reports.
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1. While working with the profile, click the Reportstab.

2. In the Available Reports panel title bar, click the Change View icon.

A list of available views appears.

3. Click the view to change to.

To return to the current view from the list of available views, click Close in the heading
of the list. The list of available views closes and the current view does not change.

N5C0001

About accessing a profile view through a URL
Users can access each view defined in the profile options through a distinct URL:

http://server-name/profile-name/view-name/index.html

where server-name is the URL that was entered during installation, profile-name is the
short profile name, and view-name is the name of the view (not the title). The ability to
access a view through a URL is a convenient way for users to view the reports that are
of the most interest to them.

If an authenticated user who does not have the privilege for changing views attempts to
access a view other than the user's default view (and the view the user is trying to
access is not restricted by Web server security settings), the application cannot control
attempts to access views which are restricted by Web server security settings.

N530001

Customizing the NetInsight interface
■ About profile views
■ About dimension lists
■ About filter lists
■ About metric lists
■ About the profile default role, view, and reporting mode
■ About role default view settings

N530007

About profile views
A profile view is a set of lists:

• Dimension list

• Metric list

• Filter list

• Report list
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You can create profile views to make it more convenient for users who want to view
only a subset of, or to provide convenient access to, customized dimensions, filters,
metrics, and reports. Views also allow you to group the dimensions, filters, metrics, and
reports into folders that may be more intuitive or convenient for your users.

You can combine profile views with user authentication to block some users from
viewing some reports.

A default profile view is automatically generated when a profile is created and initially
contains all available dimensions, filters, metrics, and reports.

Before you create a profile view, you need to create the dimension list, filter list,
metric list, and report list you want to use in the profile and populate those lists with
the desired dimensions, filters, metrics, and reports.

N5D0001

About dimension lists
If you need to customize the list of dimensions available to users working with the
profile, you can use a dimension list. A dimension list appears in the Discovery Panel
and in the Drill to Dimension pop-up menu. The default dimension list contains all
possible dimensions. You can create other dimension lists and assign them to views.
Each view can contain one dimension list. Setting up different views with different
dimension lists can provide easier access to the relevant data for different users/roles.
For example, it may be easier for a campaign designer to use visual selection for
targeting with a subset of available dimensions.

N5E0001

About filter lists
If you need to customize the list of filters available to users working with an profile, you
can use a filter list. A filter list appears on the Discovery Panel. The default filter list
contains all possible filters. You can create other filter lists and assign them to views.
Each view can contain one filter list. Setting up different views with different filter lists
can provide easier access to the relevant filters for different users/roles. For example,
sales representatives in the Northeast could have custom filter groups that narrow the
prospects to their particular region and sub-regions. Sales representatives in the
Southeast would have a different set of filters pertinent to their geography.

N5F0001

About metric lists
If you need to customize the list of metrics available to users working with the profile,
you can use a metric list. A metric list appears on the Discovery Panel. The default
metric list contains all possible metrics. You can create other metric lists and assign
them to views. Each view can contain one metric list. For example, you could create a
metric list for power users that contains all possible metrics and a simplified metric list
for other users that eliminate uncommon metrics (for example, removing min and max
purchases, but leaving sum and average purchase metrics).

N600001
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About the profile default role, view, and reporting
mode
You can change the default role, default view, and default reporting mode for a profile.
(The initial values are specified using the system-wide default role, view, and reporting
mode settings specified by your administrator for profiles of this type.) The default role,
view, and reporting mode are used for all users who do not have an explicit role, default
view, or reporting mode specified in the administrative options. The default role, view,
and reporting mode also affect users who have not logged on before accessing the
profile.

Administrators can also set the default role, view, and reporting mode to apply to each
new profile users create.

If you specify the default role of (No Access) for the profile, it is used for all users
who do not have a role for this profile specifically assigned in the profile settings for
the user. The user's default role is not used. Select (No Access) to limit access to
this profile to those users who have a role for this profile specified in the
administrative options and who are logged on. Users must log on to access the
profile.

If you select Sample as the default reporting mode and a sample size has not been
specified for the profile, Unica NetInsight uses the Full reporting mode. If a user does
not have permission to view full reports, the user sees an error when no sample size is
specified.

N610001

About role default view settings
You can assign each role a default view for each profile. The default view is for users
who have that role for the profile, but who do not have an assigned default view for the
profile.

N540001

Working with report lists
■ To create a report list
■ To edit a report list
■ To copy a report list
■ To manage folders for a report list
■ To delete a report list

N540009

To create a report list
1. While working with the profile, click Options.

2. In the left panel, under Interface, click Report Lists.

The Report list definitions screen opens.
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3. Click Add.

The Report list description screen opens.

4. In the Name of report list field, enter the one-word name for the report list.

The name is used internally. You may only use alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the report
list, you cannot change the name.

5. In the Title of report list field, enter a title for the list.

The title appears as the heading of the report list in the left panel of the Reports tab
and in the Discovery Panel.

6. Click Save Options, then click Continue.

You must now create folders for the report list.
N620001

To edit a report list
1. While working with the profile, click Options.

2. In the left panel, under Interface, click Report Lists.

The Report list definition screen opens.

3. Select the report list to edit.

4. Click Edit.

The Report list description screen opens.

5. In the Title of report list field, enter a title for the list.

The title appears as the heading of the report list in the left panel of the Reports tab
and in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create folders for the report list.
N630001

To copy a report list
You can quickly create a new report list with the same folder and reports definitions as
an existing report list by copying it. You can then edit the report list's folders. This may
be quicker than creating a new report list.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Metric Lists.

The Report list definition screen opens.

3. Select the report list to copy.

4. Click Copy.

The Report list description screen opens.
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5. In the Name of report list field, enter the one-word name for the report.

The name is used internally. You may use only alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the report
list, you cannot change the name.

6. In the Title of report list field, modify a title for the list as needed.

The title appears as the heading of the report list in the left panel of the Reports tab
and in the Discovery Panel.

7. Click Save Options, then click Continue.

You can now modify folders for the report list.
N640001

To manage folders for a report list
To modify folders immediately after creating a report list, start with step 5. Otherwise,
start with step 1.

1. While working with the profile, click Options.

2. In the Options panel, select Interface > Report Lists.

The Report list definition screen opens.

3. Select the report list for which to manage folders.

4. Click Folders.

The Folder definitions screen opens.

5. To add a folder to the report list:

a. Click Add.

b. In the Title of folder field, enter a title.

c. Click Save Options, then click Continue.

d. Continue with step 8 below.

6. To edit an existing folder name:

a. Select the folder.

b. Click Edit.

c. In the Title of folder field, enter a title.

d. Click Save Options, then click Continue.

e. Continue with step 8 below.

7. To delete an existing folder:

a. Select the folder.

b. Click Delete.

c. Click Continue.
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8. To manage reports in the folder:

a. Select the folder.

b. Click Reports.

c. Click Add to add a report.

Then select a report from the Report source list, and optionally change the Report
title field. Click Save Options, then click Continue.

d. Select a report and click Delete to remove a report from the group.

Then click Continue.

e. Select a report and click Edit to modify the report.

Then select a report from the Report source list, and optionally change the Report
title field. Click Save Options, then click Continue.

f. Click Save Options, then click Continue.

9. Click Back to Groups when finished modifying folders.
N650001

To delete a report list
If the report list is currently selected for a view, when you delete the report list, it is
removed from the view.

1. While working with the profile, click Options.

2. In the Options panel, select Interface > Report Lists.

The Report list definition screen opens.

3. Select the report list to delete.

4. Click Delete.

5. Click Continue.
N550001

Working with metric lists
■ To create a metric list
■ To edit a metric list
■ To copy a metric list
■ To manage groups for a metric list
■ To delete a metric list

N550009

To create a metric list
1. While working with the profile, click Options.

2. In the left panel, under Interface, click Metric Lists.
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The Metric list definition screen opens.

3. Click Add.

The Metric list description screen opens.

4. In the Name of metric list field, enter the one-word name for the metric list.

The name is used internally. You may use only alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the metric
list, you cannot change the name.

5. In the Title of metric list field, enter a title for the list.

The title appears in the list of metric lists. The title also appears as the heading of
the metric list in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create groups for the metric list.
N660001

To edit a metric list
1. While working with the profile, click Options.

2. In the Options panel, select Interface > Metric Lists.

The Metric list definition screen opens.

3. Select the metric list to edit.

4. Click Edit.

The Metric list description screen opens.

5. In the Title of metric list field, enter a title for the list.

The title appears in the list of metric lists. The title also appears as the heading of
the metric list in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create groups for the metric list.
N670001

To copy a metric list
You can quickly create a new metric list with the same group definitions as an existing
metric list by copying it. You can then edit the metric list's groups. This may be quicker
than creating a new metric list.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Metric Lists.

The Metric list definition screen opens.

3. Select the metric list to copy.

4. Click Copy.
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The Metric list description screen opens.

5. In the Name of metric list field, enter the one-word name for the metric.

The name is used internally. You may use only alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the metric
list, you cannot change the name.

6. In the Title of metric list field, modify a title for the list as needed.

The title appears in the list of metric lists. The title also appears as the heading of
the metric list in the Discovery Panel.

7. Click Save Options, then click Continue.

You can now modify groups for the metric list.
N680001

To manage groups for a metric list
Groups organize the metrics available within each metric list. Groups appear as
expandable folders of metrics in the metric list. Groups may not contain other groups.

To modify groups immediately after creating a metric list, start with step 5. Otherwise,
start with step 1.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Metric Lists.

The Metric list definition screen opens.

3. Select the metric list for which to manage groups.

4. Click Groups.

The Group definitions screen opens.

5. Add, edit, and delete groups as necessary.

6. To manage metrics in the group:

a. Select the group.

b. Click Metrics.

c. Click Add to add a metric.

Then select a metric from the Metric source list, and optionally change the Metric
title field. Click Save Options, then click Continue.

d. Select a metric and click Delete to remove a metric from the group.

Then click Continue.

e. Select a metric and click Edit to modify the metric.

Then select a metric from the Metric source list, and optionally change the Metric
title field. Click Save Options, then click Continue.

f. Click Save Options, then click Continue.
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7. Click Back to Groups when finished modifying metrics.
N690001

To delete a metric list
If the metric list is currently selected for a view, when you delete the metric list, it is
removed from the view.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Metric Lists.

The Metric list definition screen opens.

3. Select the metric list to delete.

4. Click Delete.

5. Click Continue.
N560001

Working with dimension lists
■ To create a dimension list
■ To edit a dimension list
■ To copy a dimension list
■ To manage groups for a dimension list
■ To delete a dimension list

N560009

To create a dimension list
1. While working with the profile, click Options.

2. In the Options panel, select Interface > Dimension Lists.

The Dimension list definition screen opens.

3. Click Add.

The Dimension list description screen opens.

4. In the Name of dimension list field, enter the one-word name for the dimension.

The name is used internally. You may only use alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the
dimension list, you cannot change the name.

5. In the Title of dimension list field, enter a title for the list.

The title appears in the list of dimension lists. The title also appears as the heading
of the dimension list in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create groups for the dimension list.
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To edit a dimension list
1. While working with the profile, click Options.

2. In the Options panel, select Interface > Dimension Lists.

The Dimension list definition screen opens.

3. Select the dimension list to edit.

4. Click Edit.

The Dimension list description screen opens.

5. In the Title of dimension list field, enter a title for the list.

The title appears in the list of dimension lists. The title also appears as the heading
of the dimension list in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create groups for the dimension list.
N6B0001

To copy a dimension list
You can quickly create a new dimension list with the same group definitions as an
existing dimension list by copying it. You can then edit the dimension list's groups. This
may be quicker than creating a new dimension list.

1. While working with the profile, click Options.

2. In the Options panel, select Interface > Dimension Lists.

The Dimension list definition screen opens.

3. Select the dimension list to copy.

4. Click Copy.

The Dimension list description screen opens.

5. In the Name of dimension list field, enter the one-word name for the dimension.

The name is used internally. You may only use alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the
dimension list, you cannot change the name.

6. In the Title of dimension list field, modify a title for the list as needed.

The title appears in the list of dimension lists. The title also appears as the heading
of the dimension list in the Discovery Panel.

7. Click Save Options, then click Continue.

You can now modify groups for the dimension list.
N6C0001
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To manage groups for a dimension list
Groups organize the dimensions available within each dimension list. Groups appear as
expandable folders of dimensions in the dimension list. Groups may not contain other
groups.

To modify groups immediately after creating a dimension list, start with step 5.
Otherwise, start with step 1.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Dimension Lists.

The Dimension list definition screen opens.

3. Select the dimension list to add groups to.

4. Click Groups.

The Group definitions screen opens.

5. Add, edit, and delete groups as necessary.

6. To manage dimensions in the group:

a. Select the group.

b. Click Dimensions.

c. Click Add to add a dimension.

Then select a dimension from the Dimension source list, and optionally change the
Dimension title field. Click Save Options, then click Continue.

d. Select a dimension and click Delete to remove a dimension from the group.

Then click Continue.

e. Select a dimension and click Edit to modify the dimension.

Then select a dimension from the Dimension source list, and optionally change the
Dimension title field. Click Save Options, then click Continue.

f. Click Save Options, then click Continue.

7. Click Back to Groups when finished modifying dimensions.
N6D0001

To delete a dimension list
If the dimension list is currently selected for a view, when you delete the dimension list,
it is removed from the view.

1. While working with the profile, click Options.

2. In the Options panel, select Interface > Dimension Lists.

The Dimension list definition screen opens.

3. Select the dimension list to delete.
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4. Click Delete.

5. Click Continue.
N570001

Working with filter lists
■ To create a filter list
■ To edit a filter list
■ To copy a filter list
■ To manage groups for a filter list
■ To delete a filter list

N570009

To create a filter list
1. While working with the profile, click Options.

2. In the Options panel, select Interface > Filter Lists.

The Filter list definition screen opens.

3. Click Add.

The Filter list description screen opens.

4. In the Name of filter list field, enter the one-word name for the filter.

The name is used internally. You may only use alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the filter
list, you cannot change the name.

5. In the Title of filter list field, enter a title for the list.

The title appears in the list of filters lists. The title also appears as the heading of the
filter list in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create groups for the filter list.
N6E0001

To edit a filter list
1. While working with the profile, click Options.

2. In the left panel, under Interface, click Filter Lists.

The Filter list definition screen opens.

3. Select the filter list to edit.

4. Click Edit.

The Filter list description screen opens.

5. In the Title of filter list field, enter a title for the list.
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The title appears in the list of filter lists. The title also appears as the heading of the
filter list in the Discovery Panel.

6. Click Save Options, then click Continue.

You can now create groups for the filter list.
N6F0001

To copy a filter list
You can quickly create a new filter list with the same group definitions as an existing
filter list by copying it. You can then edit the filter list's groups. This may be quicker than
creating a new filter list.

1. While working with the profile, click Options.

2. In the Options panel, select Interface > Filter Lists.

The Filter list definition screen opens.

3. Select the filter list to copy.

4. Click Copy.

The Filter list description screen opens.

5. In the Name of filter list field, enter the one-word name for the filter.

The name is used internally. You may only use alphanumeric characters and
hyphens, and the first character must be a letter. Once you have created the filter
list, you cannot change the name.

6. In the Title of filter list field, modify a title for the list as needed.

The title appears in the list of filter lists. The title also appears as the heading of the
filter list in the Discovery Panel.

7. Click Save Options, then click Continue.

You can now modify groups for the filter list.
N700001

To manage groups for a filter list
Groups organize the filters available within each filter list. Groups appear as expandable
folders of filters in the filter list. Groups may not contain other groups.

To modify groups immediately after creating a filter list, start with step 5. Otherwise,
start with step 1.

1. While working with the profile, click Options.

2. In the left panel, under Interface, click Filter Lists.

The Filter list definition screen opens.

3. Select the filter list for which to manage groups.

4. Click Groups.
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The Group definitions screen opens.

5. Add, edit, and delete groups as necessary.

6. To manage filters in the group:

a. Select the group.

b. Click Filters.

c. Click Add to add a filter.

Then select a filter from the Filter source list, and optionally change the Filter title
field. Click Save Options, then click Continue.

d. Select a filter and click Delete to remove a filter from the group.

Then click Continue.

e. Select a Filter and click Edit to modify the filter.

Then select a filter from the Filter source list, and optionally change the Filter title
field. Click Save Options, then click Continue.

f. Click Save Options, then click Continue.

7. Click Back to Groups when finished modifying filters..
N710001

To delete a filter list
If the filter list is currently selected for a view, when you delete the filter list, it is
removed from the view.

1. While working with the profile, click Options.

2. In the Options panel, select Interface > Filter Lists.

The Filter list definition screen opens.

3. Select the filter list to delete.

4. Click Delete.

5. Click Continue.
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10 Using the Overlay
Viewer

■ About the Overlay Viewer
■ To launch the Overlay Viewer
■ To add a Unica NetInsight connection
■ To connect to NetInsight
■ Overlay Viewer options

N720001

About the Overlay Viewer
The Unica NetInsight Overlay Viewer is a plug-in to Internet Explorer that overlays links
on your Web site with a color-coded heat map, allowing you to see which links are the
most popular. From there you can drill into Unica NetInsight reports for greater detail.

The Overlay Viewer does not recognize links that point to JavaScript functions or
links in Flash animations.

To install the Overlay Viewer, download and run the Overlay Viewer installer
(nioverlay-<version>.exe). The installer is available for download from the
Software Downloads section of Unica ’s Customer Central Web site (account required).
If you do not have access to Customer Central, consult your Unica NetInsight
administrator to see if a local copy of the installer is available.

The Overlay Viewer will install with Internet Explorer only.
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To launch the Overlay Viewer
To launch the Overlay Viewer:

1. In Internet Explorer, navigate to the Web site whose statistics you want to see.

The URL you enter in the Internet Explorer address bar must match the URL for the
site as it was specified in Unica NetInsight when the profile was created. For
example, if the URL for the site was specified in Unica NetInsight as
http://www.mysite.com, http://mysite.com will not work. Consult your Unica
NetInsight administrator if you are not sure of the correct URL.

2. On the Internet Explorer toolbar, click the Unica NetInsight icon (or select View >
Explorer Bar > Unica NetInsight Overlay Viewer).

If your Unica NetInsight installation is protected by HTTP authentication, enter your
HTTP user name and password when prompted.

The first time you launch the Overlay Viewer, you will only see a Configure and a Help
icon. You must connect the Overlay Viewer to Unica NetInsight before the rest of its
features become available.

N740001
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To add a Unica NetInsight connection
Before you can connect the Overlay Viewer to Unica NetInsight, you must specify
connection information for the installation.

1. In the Overlay Viewer explorer bar, click the Configure icon.

2. In Unica NetInsight Connections, click Add.

3. In the Name box, enter the name you want to use for this installation in the Unica
NetInsight Connections list. This can be anything you choose.

4. In the URL box, enter the full URL path to your Unica NetInsight homepage. You
can copy the path from your browser's address bar while viewing your Unica
NetInsight homepage.

5. If your Unica NetInsight installation requires you to log in, click More.

• If your Unica NetInsight installation requires HTTP authentication to access the
server, enter your HTTP user name and password. Internet Explorer can not
access this information, so you might still need to enter an HTTP user name and
password when you click the Unica NetInsight icon during subsequent logins.

• If your installation requires you to log in to Unica NetInsight itself, enter your
Unica NetInsight user name in the Unica NetInsight User box and your
password in the second Password box.

6. Click Test to test the connection,

7. Click OK to add this installation to the Unica NetInsight Connections list.
N750001

To connect to NetInsight
After you have created one or more connections to Unica NetInsight, connect as
follows:

1. After launching the Overlay Viewer, In the Overlay Viewer explorer bar, click
Configure.

2. Select the connection you want and click Connect.
N760001

Overlay Viewer options
Display and data options
The Overlay Viewer explorer bar has four parts: the icons, the Profile section, the
Overlay section, and the Report section. The first time you open the Overlay Viewer
explorer bar, it will contain only a Configure icon and a Help icon. You will need to
connect to a Unica NetInsight installation before you can see the rest of the Overlay
Viewer explorer bar.
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Option Description To Change

Toggle Overlay You can toggle between displaying the In the Overlay Viewer explorer bar, click
overlay and viewing the Web site with- the Toggle Overlay icon. This icon is a
out the overlay. right-pointing triangle when overlay is

off and two parallel lines when overlay
is on.

Current Profile The data that displays in the overlay In the Overlay Viewer explorer bar, click
comes from a Unica NetInsight profile. Profile in the title bar of the top section
You can change the profile from which and select the profile you want from the
the data is taken. list of all profiles in all installations for

which a connection exists.

Display Type There are three overlay display types: In the Overlay Viewer explorer bar, click
bar chart, heat map, and link outline. Overlay in the title bar of the bottom
The options in the Overlay section section. Select:
change depending on the display type.

• Bar Chart to display small bar
charts next to the most popular
links. The bar charts will also show
the percentage of the selected met-
ric that clicked that link.

• Heat Map to see bars of color over
the most popular links. The more
intense the bar, the more popular
the link.

• Link Outline to see the colored out-
line of a box around the most popu-
lar links. The more intense the col-
or, the more popular the link. The
outline will also show the number of
the selected metric that clicked the
link.

Mouse over any link on the Web page
to view the link's full URL and the
values for the currently selected met-
rics.

Transparency The Transparency option determines In the Overlay section of the Overlay
the intensity of the color of the bar Viewer explorer bar, click Transparen-
charts, heat map, or link outlines. cy and select a percentage.

Maximum number The Maximum # of links option deter- In the Overlay section of the Overlay
of links mines how many links on your Web site Viewer explorer bar, click Maximum #

will have a bar chart, heat map, or link of links and select a number from the
outline. list or select Unlimited.
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Option Description To Change

1. In the Overlay section of the Over-Metric The Metric option determines what cri-
lay Viewer explorer bar, click Met-teria is used to determine the most
rics.popular links. Bar chart overlays can

display multiple metrics. Heat map and 2. Move the metrics you want to use
link outline overlays display whichever into the Selected metrics list. Re-
metric is first in the Selected metrics move any metrics you do not want
list. to use.

3. Put the metrics in the order in which
you want them. Select a metric in
the Selected metrics list and click
the Move Up or Move Down button
to move the metric in the list. (Heat
map and link outline overlays only
display the metric that appears first
in the Selected metrics list.)

Color The Color option determines the color In the Overlay section of the Overlay
of the heat map or link outlines. (The Viewer explorer bar, click Color.
Color option is not available for bar
chart overlays.)

Current Report You can select a report to display in the In the Report section of the Overlay
Overlay Viewer explorer bar. You can Viewer explorer bar, click Report.
make changes to the reports using the
Custom Report Wizard in Unica NetIn-
sight.

Drill Anywhere From the Overlay Viewer, you can gen- Click the Filter icon:
erate a new Unica NetInsight report that

• To see a report that is filtered onuses the Web site page you are viewing
the current Web page, select Drillas a filter. The report will be displayed
to Report and select the report.in Unica NetInsight. Click the Filter icon:

• To generate a trend report that is
filtered on the current Web page,
select Trend By and select a time
period.

Update Data This will retrieve the latest data from the In the Overlay Viewer explorer bar, click
profile. the Refresh Overlay icon or press

Alt+F5.

Date range options
You select the time frame from the calendar. The tabs along the bottom of the calendar
are (from left to right) View Month, View Quarter, View Year, View All, View Custom,
and Apply Calendar.
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Option Description

View Month Display data from the shown month. If the profile contains data for a
day, it is shaded. If the Overlay Viewer displays data for only some
of the days for which the profile contains data in the month, these
days are grayed.

View Quarter Display data from the shown quarter.

View Year Display data from the shown year.

View All Display data from the profile’s entire date range.

View Custom Specify a custom time period.

Apply Calendar Regenerate the current report using the time period specified in the
calendar.
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■ About regular expressions
■ Basics of regular expressions
■ Metacharacters
■ Metacharacter examples
■ Special characters
■ Special character examples
■ Combining metacharacters
■ Using regular expressions

N770002

About regular expressions
You can use regular expressions when setting profile options.

Depending on the database you are using, you may also be able to use regular
expressions when setting filters for reports. This lets you find specific report data quickly
and accurately. The syntax is similar to that used in Perl.

If you are unfamiliar with regular expression syntax, there are many tutorials on the
Internet.

N780002
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Basics of regular expressions
A regular expression is a way of specifying a pattern in a text string. For example, if you
specify the pattern somephrase the regular expression rules matching engine finds any
instance of the text somephrase in the field you are searching. It matches
somephrase, somephrases, abcsomephrase123, and Here is somephrase.

To cite a more useful example, you can use regular expressions to generate a report on
all requests for HTM and HTML files on your site. In the Included Pages option, enter
the filter that match the regular expression htm. This gives you a report on any page
that has htm in its file name. Assuming you have not used htm as anything other than a
file extension, you will get a report on all requests for HTML files. The report will include
requests for files ending with html because the string html includes the string htm.

This assumes that either all your file names have lowercase extensions or that you
have not enabled case-sensitivity in your profile options. (When case-sensitivity is
not enabled, all pages, files, clips, and user names are imported as lowercase
characters.

N790002

Metacharacters
The real power of regular expressions is in the use of metacharacters. Metacharacters
allow you to construct expressions that match specific text patterns in an extremely
flexible way.

The following table lists and describes the metacharacters.

Metacharacter Meaning

. (period) Matches any one character no matter what the character is

? Matches the character immediately before it either zero times or one
time

* Matches the character immediately before it any number of times
including zero (the character may not be in the string at all)

+ Matches the character immediately before it one or more times (the
character must be in the string at least once)

^ Indicates that the characters which follow are at the start of the
string only

$ Indicates that the characters which precede it are at the end of the
string

\d Matches any single decimal digit (0-9)
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Metacharacter Meaning

\D Matches any character that is not a decimal digit

\s Matches a tab or space character

\S Matches any character that is not a tab or a space

\w Matches any letter, any digit, or the underscore character

\W Matches any character which is not a letter, a digit, or the
underscore

\ Escape character allowing the use of any of the metacharacters with
their regular keyboard meaning. For example, \. matches a period (.)
in a regular expression. (A period (.) without a preceding escape
character matches any one character no matter what the character
is.)

N7A0002

Metacharacter examples
The following table shows examples that illustrate the use of metacharacters.

Regular Expression Matches Reason

up.own uptown Period (.) matches any character,
even a space.

updown

up own

.exe aexe Period (.) matches any character,
even a space.

123exe

1exejfg

\.exe .exe Backslash (\) tells the rules
matching engine you are looking

prog.exe for a period, not using the period
as a metacharacter.

ab?cdef acdef Question mark (?) matches both
zero instances of b and one

abcdef instance of b.
abcdefg

xyxacdefghij
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Regular Expression Matches Reason

ntcgi\?johnswift ntcgi?johnswift Backslash (\) tells the rules
matching engine you are looking
for a question mark, not using
the question mark as a meta-
character.

abc*defg abdefg Asterisk (*) matches the c zero
or more times.

abcdefg

xyzabcdefghij

abcccccdefg

abc+defg abcdefg Plus (+) matches the c one or
more times.

abccdefg

xygabcdefghij

abcccdefghij

free free By default, text is matched
wherever it is found in the text

freedom string.
innisfree

^free free Caret (^) only matches the begin-
ning of the text string.

freedom

free$ free Dollar sign ($) only matches at
the end of the text string.

innisfree

N7B0002

Special characters
In addition to metacharacters, you can use four other characters to indicate the
relationships between various parts of the regular expression.

Character Meaning

| Tells the rules matching engine to match the text to the left of the
pipe or the text to the right of the pipe

[ ] Contains a set of characters and tells the rules matching engine to
match any character within that set

( ) Indicates that the part of the expression that is within the parenthe-
ses is to be considered as one unit
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Character Meaning

^ [abc] Negates the set of characters in brackets so that text must contain a
character at that point in the expression but it cannot be any of the
characters inside the brackets

N7C0002

Special character examples
The following table shows examples that illustrate the use of the special characters.

Example Matches Does Not Meaning
Match

they (would | should) they would Parentheses and pipe indicate text must
contain at least one instance of either would

they should or should
they should
have

they would
have

[cz]one cone one Brackets indicate either a c or a z must be
present for a match

zone

[^abc]xyz dxyz axyz Brackets indicate there must be a character
at that point in the expression, but the caret

mxyz bxyz indicates that character cannot be a, b, or c
cxyz

xyz

N7D0002

Combining metacharacters
You can combine several metacharacters in one regular expression. One of the most
common combinations is the period and asterisk (.*) which matches a string of any
length including the null string.

Regular Expression Matches Reason

.*\.cgi$ any string ending in .cgi The period and asterisk (.*) com-
bination matches any string. The
backslash (\) tells the matching
rules engine to look for a period,
not use the period as a meta-
character.
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Regular Expression Matches Reason

.*.cgi$ The second period is not pre-acgi
ceded by a backslash (\), so it is

thomcgi being used as a metacharacter
to match any one character nofile.cgi matter what the character is. A
more compact form of writing the
same pattern would be .+cgi.

N7E0002

Using regular expressions
You can use regular expressions when setting many options. Depending on your
database type, you can use regular expressions to define filter groups or visitor profiles
and when filtering reports. If regular expressions are not available, you can use the
special characters for pattern matching supported by your database.

For example, Unica NetInsight OnDemand uses regular expressions heavily in both its
browser and platform options. The following regular expression defines which user
agents in your log files are classified as the Microsoft Internet Explorer Web browser:

^

Mozilla/.*MSIE (\d+\.)

93

To see this regular expression: 1) display a profile; 2) click the Options tab; 3) in the
Options panel, select Visitors or Users > Browsers > Microsoft Internet Explorer >
User Agents.

If a user agent in your log file matches the regular expression above, then the browser
used by that user will be listed as Microsoft Internet Explorer in your Browser Summary.

By breaking down the regular expression, you can see exactly what it is looking for.

Expression Meaning

^ The string must start with the characters that follow (Mozilla/)

Mozilla/ The characters that must be at the beginning of the string

.* The string must start with the characters that follow (Mozilla/)

MSIE The next string of characters that must be present (including a
space after the E)

( ) The contents of the parentheses are considered a single unit

\d Matches any decimal digit
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Expression Meaning

\. Modifies the \d so the rules matching engine looks for one or more
digits

The above expression will match the following strings:

Mozilla/4.0 (compatible; MSIE 4.01; MSN 2.5; Windows 98)

Mozilla/4.0 (compatible; MSIE 4.01; Windows 95)

Mozilla/4.0 (compatible; MSIE 5.0; Windows 95; AIT; DigExt)

Unica NetInsight OnDemand - Power User's Guide

Because the regular expression includes information about the browser version
(\d+\.), if you have selected the Append the version number check box for the
browser, the first two strings above appear as Microsoft Internet Explorer 4 and the last
string will appear as Microsoft Internet Explorer 5.

Depending on your database type you can also use the That match the regular
expression filter with a regular expression when filtering a report. For example, you
could use the Custom Report Wizard to create a custom Page Summary that only
contains data for visitors who were using NetBSD, FreeBSD, or OpenBSD, but not
BSDI. You would need to enter That match the regular expression .*BSD$ as the
complete platform filter. The period and asterisk (.*) allows a match on any characters
that precede BSD in the string, but because of the dollar sign ($), the string must end in
BSD.

If you are interested in examining your server's performance when it calls CGI
programs, you can use the Custom Report Wizard to create a custom Server
Performance Summary with the filter That match the regular expression.*\.cgi$
(provided your CGI programs end with that extension). When you run the report, you will
see only statistics on how your server performs when a CGI program is called.
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